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OZET
YAKIT DONUSTURUCUDE DONUSTURULMUS
DOGALGAZ YAKITLI KATI OKSITLI YAKIT PiLi DiZIiNi
MODELLEMESI
YILMAZ, Semih
Yiiksek Lisans Tezi, Makina Miihendisligi Bolimii
Tez Yoneticisi: Yrd. Dog. Dr. Turhan COBAN
Eyliil 2010, 72 sayfa

Bu c¢alismada yakit donistiiriiciide doniistiiriilmiis dogalgaz yakith kati
oksitli yakit pili dizini modellenmistir. Birim hiicre baz alinarak analizler
yapilmustir.

Doniistiiriilmiis dogalgaz ile ¢alisan {i¢ boyutlu, diizlemsel, karsit akish bir
model dizayn edilmistir. Modelde, kat1 oksitli yakit pili dizinin akim yogunlugu
dagilimi, anot ve katot kiitle gazlar kiitle dengesi, gaz kanallar1 momentum
dengesi, gozenekli elektrotlardaki gaz gecisi, elektronik akim dengesi

incelenmistir.

Ayrica anot ve katottaki gaz dagilimlari, hiz dagilimi, polarizasyon egrisi,

glig-voltaj ve gii¢ akim yogunlugu egrileri incelenmistir. Model, sonlu elemanlar
yontemiyle COMSOL 3.5a ticari yazilimi yardimiyla gergeklestirilmistir.

Anahtar sozciikler: Yakit pili, kati oksitli yakit pili, dogalgaz, HAD
analizi, sonlu elemanlar yontemi, diizlemsel KOYP dizini, elektrokimya.



ABSTRACT

SOLID OXIDE FUEL CELL STACK MODELING

WITH PREREFORMED NATURAL GAS

YILMAZ, Semih

MSc in Mechanical Engineering

Supervisor: Yrd. Dog. Dr. Turhan COBAN

September 2010, 72 pages

In this paper , solid oxide fuel cell stack is modeled with prereformed
natural gas. Analysis has been made, which is based on unit cell.

A model designed which is working with prereformed natural gas, 3D,
planar and co-flow. At the model, range of the current density of solid oxide fuel
cell stack, mass balance of anode and cathode gases, momentum equilibrium of
gas channels, the gas transition in porous electrodes, electronic current balance are
examined.

Further, gas dispertion in anode and cathode, velocity distribution,
polarization curve, power-voltage and power-current curves are examined. The
model performed by finite element method with support of COMSOL 3.5a
commercial software.

Key words: Fuel cell, solid oxide fuel cell, natural gas, CFD analysis, finite
element analysis, planar SOFC stack, electrochemistry.
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1. GIRIS

Insanlik varolusundan bu yana enerjiye ve onu iiretecek araglara ihtiyaci
olmustur. Atesin bulunmasiyla baslayan siirecte enerji kaynagi olarak odun, kdmiir
gibi kat1 yakitlar, daha sonralar ise petrol ve dogalgaz kullanilmaya baglanmistir.

Elektrigin kesfi ile enerji kavrami daha farkli bir boyuta taginmistir.

Gliniimiize gelindiginde ise yeni bir enerji kaynagi olan ‘“hidrojen” ile
tanismis durumdayiz. Hidrojen, kullanim verimi yiiksek bir yakittir. Cevre
dostudur. Teknolojik gelisim, g¢evre etkisini de iceren efektif maliyetin diger

yakitlardan diisiik olmasini saglamistir.

Hidrojenin kullanilmasini gerektiren baglica iki neden olup, biri fosil
yakitlarin yanmalar1 sonucunda olusan karbondioksitin kiiresel 1sinmaya ve
cevresel yikima neden olmasi, digeri petrol ve dogalgaz gibi akiskan
hidrokarbonlarin  bilinen {retilebilir rezerv Omiirlerinin insan Omri ile

kiyaslanabilecek boyuta diismiis olmasidir.

Bu noktada yakit pillerinin ne denli 6nemli oldugu ortaya ¢ikmaktadir. Clinkii
diinyanin giderek daha fazla kirlendigi bilinmektedir ve bunun sonucunda da gesitli
sorunlarla kars1 karsiya kalinmaktadir. Eger diinya {izerinde fosil yakit tiiketimi bu
hizla devam edecek olursa ¢ok yakin bir zamanda diinya asir1 1sinma tehlikesi ile
kars1t karsiya kalacaktir. Bu yilizden fosil yakit tiiketiminin azaltilmasi ve daha
diisiik emisyon degerlerine ulasilmast gerekmektedir. Bu da ancak yakit pillerinin

daha yaygin olarak kullanilmasiyla gerceklesecektir.

Yakat pilleri, verimli, ekonomik, sessiz ve ¢evre ile uyumlu enerji liretiminde
kullanilan, gelecek kusaklarda ¢ok daha yaygin olarak kullanilacagi tahmin edilen
onemli enerji liretim araglarindan biridir. Yakit pilinde, yakit gazlarindaki kimyasal
enerji, diisiik enerjili, minimum hareketli parcalar iceren ve hava kirliligine sebep

olmayan elektrokimyasal bir islemde elektrik enerjisine dontistiiriiliir.

Ik yakit pilinin 1839 yilinda Sir William Grove tarafindan yapildig: kabul
edilir (Wang et al., 2007). Bu yakit pili oda sicakliginda ¢alisan, seyreltik siilfiirik

asit elektrolitli, bir hidrojen anotlu ve bir oksijen katotlu sistemdir.

Yakit pilleri, bir enerji ¢evrim aracidir. Gaz yakitlardan elektrokimyasal

tepkimelerle elektrik tiretirler. Yakit pilleri glinlimiizde kullanilan konvansiyonel



gii¢ iiretim sistemlerine gdre ¢ok fazla avantajlara sahiptirler. Ozellikle yiiksek
verimliligi, boyutlar1 ve ¢evresel etkileri bakimindan avantajli konumdadirlar.
Pratikte ilk basarili yakit pili uygulamasi 1960’larda uzay araglarinda
gergeklestirilmistir. 1980 ve 1990°Ih yillarindaki yogun calismalar sabit giic
santralleri ve ulasim araglarinda kullanilma potansiyeline kavusmustur (Priddy and
Li,1985). Bu siiregte, Polimer Elektrolit Yakit Pili (PEYP), Fosforik Asitli Yakit
Pili (FAYP), Molten Karbonatli Yakit Pili (MKYP), Kat1 Oksitli Yakit Pili (KOYP)
gelistirilmistir. Cizelge 1.1°de yakat pili ¢esitleri ayrintili olarak gosterilmistir.

Cizelge 1.1 Degisik tipteki yakat pillerinin karakteristikleri ve giincel durumu (Wang et al., 2007)

PEYP FAYP MKYP KOYP
Elektrolit Nafyon H;PO, Na,CO,-Li,CO3; | ZrO,-Y,0;
Cahsma Sicakhg | 70-80 200 650-700 900-1000
(°C)
Yakit H, H, H,, CO, CH, H,, CO, CH,
Beklenen  Verim | 30-40 35-42 45-60 45-65
(%)
Gii¢ (KW) 12.5° 100° 1000° 100° 15°
Verim (%) 40 40 45 43Y 50°
2 Allied signal.

® Fuji electric.
®MCFC Research Association, Japan.
¢ Siemens Westinghouse.

¢ Mitsubishi Heavy Industry and Electric Power Development, Japan (5 bar’da).

KOYP’leri, %65’e varan yiiksek verimlilikleri sayesinde sabit gii¢ sistemleri
icin Onemli bir potansiyel arz etmektedir. Ayrica KOYP’leri yanmali tiirbin
sistemleri ile birlikte kullanildiginda verim %70’lere kadar ¢ikmaktadir (Wang et
al., 2007).



Kat1 oksit yakit pilleri ~1000 °® C sicaklikta calisirlar ve sivi bir elektrolit
yerine sert, seramik bir elektrolit kullanirlar. Kat1 elektrolitin her iki tarafi gecirgen

0zel elektrot maddeyle kaplanmistir.

Yiiksek calisma sicakliginda, negatif yiiklii oksijen iyonlar1 kristal madde
icerisinde hareket eder. Hidrojen iceren bir yakit gazi anottan gegirildiginde negatif
yiikli oksijen iyonlari yakiti okside etmek icin elektrolitten gecer. Oksijen
genellikle katot tarafinda havadan elde edilir. Anotta olusan elektronlar harici bir
yol kat ederek elektrik devresini tamamlar ve elektrik enerjisi liretilmis olur. Kati
oksit yakit pillerinde verim %60 seviyesindedir. KOYP calisma prensibi Sekil

1.1.’de gosterilmistir.

Kat1 Oksitli Yakiat Pili

Yakat Hz0 + CO2
CO+H,0 - Hz+CO; Is1

3 K [ B
1 UAEET TSt VT .l.‘.‘

Si\A Y

‘Hg 2Hz + 20 —+ 4e- + 2H,0

H2+c°

Gecirgen ,,
Anot [}

Gecirimsiz
Elektrolit

Gecirgen
Katot

Hav> Tiikenmis O2
— Is1

Sekil 1.1 Kat1 Oksitli Yakit Pili Calisma Prensibi

Bu calismadaki amag ise dogalgaz1 yakit olarak kullanan diizlemsel bir kati

oksitli yakit pilini dizinini ele alip, sonlu elemanlar yontemi ile ii¢ boyutlu olarak



analiz etmektir. Bu maksatla, gerekli 6n parametreler belirlenip, uygun olanlar

calismada kullanilacaktir.

Gliniimiizde en yaygin aga sahip ve kolay bulunabilen bir gaz olan dogalgaz,
direkt yakilmak yerine doniistiiriilerek yakit pilinde kullanildiginda yiiksek gaz
emisyonlarina ve g¢evre Kirliligine neden olmadan, temiz ve gilivenilir bir sekilde

elektrik enerjisine gevrilir.

Oniimiizdeki yillarda yakit pilinin diinya ¢apinda enerji iiretimindeki payinin
inanilmaz sekilde artacagi ve biiyiik ragbet gorecegi tahmin edilmektedir. Enerji
stoklarimiz1 korumak, g¢evremizi korumak ve yasam kalitesini diizeltmek icgin

diinyanin enerji ihtiyaglari i¢in teknolojiden yeterince yararlanmak gereklidir.

Bu tez;
e Verimli ve giivenilir enerji liretimi,
e Az miktarda sogutma suyu kullanima,
o Kati atik, giiriiltli ve titresim olmadan enerji iiretimi,
e Zararl gazlarin ¢evreye daha az yayilmasi,
e Montaj, isletme ve bakim kolayligi,

konularinda katk: saglayacak, gelecegimiz demek olan ¢evreye ve iilkemize

faydali olacaktir.



2. ONCEKI CALISMALAR
2.1 Universitemizdeki Calismalar

Ege Universitesi Makine Miihendisligi boliimde 2005 yilindan itibaren tez
danismanim Yrd. Dog. Dr. Turhan COBAN tarafindan “yakit pilleri” ile ilgili ders
verilmektedir. Buna ek olarak DPT destekli 06-DPT-005 nolu “Dogalgaz Yakith
Kiiciik ve Orta Olgekli Kat1 Oksitli (Seramik) Yakit Pili Kojenerasyon
Sistemlerinin ~ Gelistirilmesi” projesi; Mak. Miih. Abdullah TAZEBAY’ i
hazirladigi “Dogalgaz Yakith Kati Oksitli Yakit Pili Sisteminin Bilgisayar
Benzesimi” adli yiiksek lisans tezi calismasi; Mak. Miih. Siileyman KAVAS’in
hazirladign “Dogalgaz Yakithh Kati Oksitli Yakit Pili Sistemi Igin Sabit Sicaklik
Buharli Yakit Doniistiirticti Tasarimi1” adli yiiksek lisans tezi ¢alismasi ile Yiik.
Mak. Miih. Ciineyt EZGI’nin hazirladigi “Su Ustii Savas Gemisinde NATO F-76
Dizel Yakith Kat1 Oksitli Yakit Pili Sistemi Tasarimi ve Analizi” adli doktora tezi

calismasi gergeklestirilmistir.

Yiik. Mak. Miih. Ozer OGUCLU tarafindan hazirlanan “ Dogalgaz ile Calisan
Kat1 Oksitli Yakat Pilleri icin Izotermal Buharli Yakit Déniistiiriicii Optimizasyonu
ve Dizayn1” adli doktora calismasmin ise 2010 yili sonunda tamamlanmasi
Oongoriilmektedir.

2.2 Kat1 Oksitli Yakit Pili (KOYP) ile Yapilan Cesitli Calismalar

Simdi bu teze daha yakin ¢aligmalara deginecegiz. Burada en son teknolojiye
sahip KOYP'lerinden bahsedersek, oniimiize iki farkli tasarim ¢ikar: Elektrolit veya
elektrot destekli tasarim. Daha Onceki tasarimlarda kalin elektrolitlerden (120-200
um) olusmakta ve diisiik sicakliklarda yiiksek ohmik kayiplara sebep olmaktaydi.
Daha sonraki tasarimlar kalin anot ve/veya katot destekli (400-1800 um) ve ince
elektrolit destekli (8-20 pm) tasarimlardir.

Bir sonraki agama tasarimlar elektrolitteki ohmik kayiplari1 azaltabildi. Fakat
konsantrasyon kayiplar1 gaz diflizyon direnci yiiziinden 6nem arz ettigi gorildii.
Chan et al.,2001, anot destekli hiicrenin, katot destekli hiicreye gore daha genis
araliktaki akim yogunlugu ve yliksek giic yogunlugu ile ¢aligabilecegini gosterdi
(Bove and Ubertini, 2005).



Recknagle (2003), diiz kanalli KOYP dizininde gazlarin dagilimini, sicaklik
ve akimi ii¢ boyutlu model ile sundu. Bu ¢aligmada ayn1 yonlii, karsit ve ¢apraz
akiglar Star-CD yazilimi ile arastirildi. Ayn1 yonlii akis, en iyi sicaklik dagilimi ve
en diistik sicaklik gradyenlerini verdi (Perry et al., 2008).

Pasaogullar1 ve Wang (2003), Fluent tabanl, ii¢ boyutlu, diizlemsel, elektrolit
destekli, hidrojen ile c¢alisan bir tasarim gelistirdiler. Butler- Volmer denklemini
Tafel sadelestirmesi ile elektrokimyasal kinetik hesabi1 yaptilar (Kakag vd., 2007).

Zhu (2005), ayn1 yonli akisli, diizlemsel, anot destekli model gelistirdiler.
Anot akis kanal1 boyunca laminer ve tek boyutlu akis, gozenekli anot boyunca gaz
taginimi incelediler (Wen et al.,2002).

Klein (2007), HAD- Ace ticari programi ile 2 boyutlu, boru tipi, elektrolit
destekli, i¢sel doniisiimlii metan yakith KOYP sundular. Bu modelde kismi
basinglari, akim yogunlugunu ve potansiyelini, elektronik ve iyonik fazlarda, anot
tarafinda hesapladilar (Hussain et al., 2007).

Janardhanan ve Deutschmann (2006, 2007), igsel doniisiimlii kat1 oksit yakit
pilinin HAD analizini yaparak, tasinim, heterojen kataliz ve elektrokimyasal
prosesleri incelendiler (Ho et al., 2007). Ayrica nemlendirilmis metan yakithi kati
oksitli yakit pilleri tizerinde kiitle ve 1s1 transferi niimerik analizleri {izerine
calistilar (Holtappels et al., 1999)



3. KATI OKSITLI YAKIT PiLI SISTEMI
3.1. Kat1 Oksitli Yakat Pili
3.1.1. KOYP’lerinin prensipleri ve tarihi gecmisi:

Oksit iyon iletkene sahip bir KOYP’nin ¢alisma prensibi Sekil 3.1 ve
Sekil 3.2°de gosterilmistir. Hiicreye bir dis kuvvet uygulandig1 zaman, oksijen,
oksit iyonlar1 olusturmak icin gecirgen hava elektrotunda indirgenir. Bu
iyonlar kati elektrolitten gecerek yakit elektrotuna gelirler ve yakitla
tepkimeye girerler, H, veya CO, H,O veya CO, iiretirler. Alternatif olarak
proton ileten kati elektrolit kullanilabilir.

Elektrik Akimi
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Sekil 3.1. KOYP Caligma prensibi

Alternatif olarak, H,’nin oksitlenerek, akabinde oksijenle tepkimeye giren ve

su olusturan bir proton ileten kat1 elektrot da kullanilabilir. Baz1 durumlarda, CO;

ve H,0 olusturmak i¢in CHy4 direkt olarak anot iizerinde oksitlenebilir. Acik devre

voltaji, E,, Katottaki Poc) ve anottaki Pom) oksijenin kismi basinglardan veya

elektrokimyasal tepkimenin serbest enerji degisiminden (AG) hesaplanabilir.
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Sekil 3.2 KOYP Calisma diyagranu

Bu denklemde “R” (J/(mol.K)) gaz sabiti, “T (K)” mutlak sicaklik, “F
(C/mol)” Faraday sabiti ve “n” oksijenin elektron karsiligi (n=4). 1000°C’de
katkisiz hidrojen ve hava ile KOYP’nin hiicre voltaji yaklasik olarak 1V tur. Hiicre
voltaji1, akimin, polarizasyon sebebi ile emilmesiyle birlikte diiser. Hiicrenin toplam
polarizasyonu, 1, 1U¢ terimin toplamidir: anot polarizasyonu, m, katot
polarizasyonu, 1, ve rezistans polarizasyonu, 1. Polarizasyon elektrotun
malzemesine, elektrolite, hiicre tasarimina ve c¢alisma sicakligina baglhdir.
1000°C’de calisan ilk KOYP, Baur ve Preis tarafindan 1937°de imal edilmistir
(Wang et al., 2007).

Nernst 1899°da, agirlik¢a %15-Y,03 ile ZrO,’nin kat1 bir oksit iyon iletkeni
oldugunu kesfetti (Wang et al., 2007). Su anda en gelismis KOYP’inde % 8-10 mol
Y203 (YSZ) ile itriyum dengeli zirkonyum elektrolit olarak kullaniliyor.

YSZ’nin oksit iyon iletkenligi, 1000 ©°C’de, 0,1 Siemens/cm (S/cm)
civarindadir. Elektrolitle birlikte diger KOYP elemanlar1 i¢in yillardir ¢alismalar
stiriyor, ancak yiliksek ¢aligsma sicakliklari, malzeme se¢imini limitli kiliyor. Baur
ana Preis’in ilk KOYP’lerinde, anot olarak demir veya karbon kullanild1 (Wang et
al.,, 2007). Westinghouse Electric’ten Weissbart ve Ruka (simdi Siemens
Westinghouse Power, (SWH) 1962’de platin kullandilar (Wang et al., 2007). Su
siralar nikel, yiiksek katalitik aktivitesi ve diisiik maliyeti dolayisi ile en g¢ok

kullanilan malzemedir.



Nikel-YSZ madeni seramik anot, 500°C gibi diisiik sicakliklarda ¢alisabilir.
Katot malzemeleri, oksitleyici ortamda kararl, iyi elektrik iletkenligine sahip ve
caligma sartlar1 altinda, oksijen indirgenmesi i¢in yeterli katalitik aktiviteye sahip
olmas1 gerekir. Bir¢ok tip katot malzemesi incelenmistir. Baur ve Preis, katot olarak
FesO,4 kullandilar. Fe3Og4tin elektrik iletkenligi oda sicakliginda 102 S/cm gibi
yiiksek degere sahiptir ancak katalitik aktivitesi yeterli degildir. Weissbart ve Ruka
katot olarak platin kullandilar (Wang et al., 2007). KOYP’lerinde alagimlar, 1sil
genlesmeler ve diger hiicre bilesenleriyle uyugsmamasindan dolayr sorunlara sebep
olmustur. Cizelge 3.1, en gelismis SWH SOFC i¢in hiicre bilesenlerini,
malzemeleri ve tiretim yontemlerini Ozetliyor. Birka¢ farkli yapida KOYP’leri
gelistirmistir.

Cizelge 3.1 Hiicre bilesenleri, malzemeler ve SWH KOYP iiretim yontemleri

Bilesen Malzeme Kalmlik | Uretim Yontemi
Hava elektrot tiplii Dolgulu LaMnO 2,2 mm Cikarma
Elektrolit Zr0,-Y,04 40 mm EVD
Yakait elektrot Ni- ZrO2-Y,0; 100 mm Bulamag kapli EVD
Ara baglant1 Dolgulu LaCrO3 85 mm EVD

[lk KOYP modiilii, Brown Boveri tarafindan 1975’te tanitilmistir (Wang et
al., 2007). Modiil, konik tiip seklindeki hiicreleri i¢ ice gecirerek yapilmistir.
Komsu hiicrelerin anot ve katodunun temasi, seriler halinde imal edilerek saglandi.
Havada ve yakit atmosferinde, elektronik temas ve sizdirmazlik saglamak icin

birbirlerine bagli malzemeler kullanilir (dolgulu CoCr;04 veya LaCrOs). H; ve



hava, reaksiyon gazi olmakla beraber, 120 seri bagli hiicreli modiilde, 0,22
W/cm?ye esdeger, 110-120 V toplam voltaj ve maksimum 115W’lik bir gii¢ ¢ikisi
elde edildi. Bu modiil konsepti, biliylik pillerin imalatinda karsilasilan
dezavantajdan etkilenmistir, nispeten daha pahali bir imalat yontemidir. Bu
yontemde birgok tek hiicre iiretilmeli ve seriler seklinde baglanmalidir. Daha sonra,
basitlestirme ve hiicre imalat maliyetini diisiirmek i¢in kimyasal buhar ¢oktiirme

veya plazma piiskiirtme gibi ince film teknikleri kullanilabilir.

Bir gozenekli elektrot tabakasi, bir sik1 gaz ZrO; elektrolit film tabaka ve bir
sik1 ara baglanti malzemesi ile ayni zamanda iyi bir ikinci gozenekli elektrot,
yiikksek gegirgen seramik destegin iizerine uygulandi. 1970°de Westinghouse bu
KOYP kavramini kullanan bir 100 kW’lik kdmiir yakith hiicre elektrik santrali
teklif etti. Bu zamanlarda, seri olarak baglanmig hiicreler Omiir ve performans
olarak tatmin edici goziikmedi, proje durduruldu. Daha sonra, Westinghouse,
1980°de contasiz bir tlip seklinde tasarim teklif etti. Bu tip hiicrenin malzeme ve
fabrikasyon islemleri Cizelge 3.1°de gosterilmistir. Giiniimiizde, Westinghouse
tarafindan ilk teklif edildiginden 30 yil sonra, 100 kW biiyiikliigiinde bir KOYP
tekrar denenmektedir. Westinghouse tarafindan 1969°da teklif edilen seriler halinde
parcali hiicre tasarimi, Japonya’da Electric Technical Laboratory tarafindan
degistirildi ve 10 kW biyikliigiinde bir iinite Electric Power Development

tarafindan test edildi.

Bir¢cok modifiye edilmis diizlemsel tasarim son yirmi yil i¢inde Onerildi.
Monolitik bir KOYP tasarimi Argonne National Laboratory tarafindan 1984’te
Onerilmistir. Bu tasarim, kiiciik hiicre boyutu ve genis aktif alan1 sayesinde daha
yiiksek gilic yogunluguna ulagma potansiyeline sahiptir. Monolitik KOYP i¢in gii¢
yogunlugu 8 kW/kg veya 4 kW/l civarinda hesaplanir. Monolitik tasarimin

olabilirligi, sadece laboratuar ortaminda anlasilabilir.

Oksijen indirgenmesi icin platinin yliksek katalitik aktivitesi sebebi ile
elektrot reaksiyonlarindan kaynaklanan polarizasyon 6nemli degildir. Yiiksek
sicakliklarda platinin buharlagsmasi ihmal edilemez oldugundan ve maliyetin yiiksek
olmasi dolayis1 ile biiyiik 6lgekli KOYP’lerinde platin katot kullanilma sansi
yoktur. Perovskite ailesinden bazi karmasik oksitler, elektrik iletkenligi gbz 6niinde
bulundurulunca gereklilikleri saglayabilirler. General Electric’den Tedmon,
1969°da perovskite’in (PrCoQOs3) katot olarak performansiyla ilgili calismalar yapti.
6 ayin iizerinde, 1000°C’de sabit bir gii¢c yogunlugu elde edildi (0,3 W/cm?). Bu tip



katot malzemelerinin dezavantajlari, 1s1l genlesme uyumsuzlugu ve elektrolit ile
uyusmazlikti. Su anda, katot malzemesi olarak genellikle iyilestirilmis lantanyum
manganit kullaniltyor. Ancak, orta sicakliklarda c¢alisan KOYP (500-700°C)
gelistirmek i¢in, diisiik sicakliklarda, yiiksek performansla c¢alisacak yeni katot
malzemeleri gelistirilmesine ihtiya¢ vardir. 1000°C’de ¢alisgan KOYP’lerindeki ara

baglant1 malzemesi i¢in temel gereklilikler sadece birkag oksit sistemde mevcuttur.

KOYP’lerindeki ara baglanti malzemesi, oksitleyici ve indirgenmis
atmosferler altinda kararli olmalidir ve her ortamda yeterli elektronik iletkenlige
sahip olmalidirlar. lyilestirilmis lantanyum kromit, yakit ve oksitleyici atmosfer
altinda yiiksek elektronik iletkenligine gore daha uygundur. Lantanyum kromit
(LaCrOs3) 1970’lerden beri KOYP ara baglanti malzemesi olarak kullanilmaktadir.
Su siralar, 5 w/o (agirlik orani) Fe ile Cr alagimlar1 ve 0,4-1,0 w/o Y,03; veya
Cr,037lin metalik baglayicilari, LaCrOs’e alternatif olarak degerlendirilebilir. Bu
alasimlar, YSZ’nin 1s1l genlesmesine ¢ok benzer bir 1s1l genlesme katsayisina
sahiptiler ancak ara baglanti malzemeleri, oksitleyici atmosferde ve yiiksek

sicakliklarda daha az 1s1 dayanikliligina sahip ve diizensizdirler.

Daha gelismis bir monolitik konfiglirasyon tasarimi1 Chubu Electric Power Co
ve Mitsubushi Heavy Industry tarafindan gelistirilmistir ve adi Mono Block Layer
Built (MOLB) konulmustur. 5 kW 6lgeginde bir MOLB tipi KOYP’i imal edilmis
ve basarili neticelere ulasilmistir. Simdiye kadar, diisiik sicaklik KOYP’leri i¢in
kabul edilebilir bir malzeme bulunamadigi i¢in biiyliik 6l¢ekli KOYP iiniteleri
1000°C civarinda g¢alismistir. 500-800°C aralifinda, daha diisiik bir c¢alisma
sicaklig1 bir¢ok avantaj saglayabilir. Maliyeti yiiksek olan lantanyum kromit
baglantilar, konvansiyonel metalik ara baglantilarla degistirilebilir ve diizlemsel
KOYP’lerindeki gaz sizdirmazlik malzemelerinin se¢imi daha kolay olabilir. 500°C
veya altinda calisan KOYP’leri, glinlimiizde elektrikli ara¢ uygulamalarinda goz
ontinde bulundurulmaktadir (Wang et al., 2007).



4. DOGALGAZ YAKITLI KATI OKSITLI YAKIT PiLI DizZiNi
MODELLEMESI

4.1. Giris

Bu model bir kat1 oksitli yakit pilindeki akim yogunlugu dagilimiyla ¢alisir.
Model, anot ve katottaki kiitle dengesinin, gaz kanallarindaki momentum
dengesinin, gozenekli elektrotlardaki gaz akisinin, oksit iyon tarafindan taginan

iyonik akim dengesinin birlesimini igerir.

4.2 Modelin Aciklanmasi

Bir KOYP ortasinda bir elektrolit bulunan iki gozenekli gaz difiizyon
elektrotundan (GDE) meydana gelir (Sekil 4.1).

Sekil 4.1 KOYP birim hiicre geometrisi.
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Burada yakit girisi anottan yapilir. Anot ve katot birbirine gore ters akishdir.
Anot tarafinda yakit doniistiiriictide doniistiiriilmiis dogalgaz, katot tarafindan ise

hava ge¢mektedir.

Pil i¢cindeki kimyasal reaksiyonlar agagida verilmistir:

Anot:

H,+0* - H,0+2e"

CO+0* - CO, +2e" (4.1)
CH,+40% —»2H,0+8¢"

Katot:

%oz +2e" — 0% (4.2)

CO elektrokimyasal reaksiyonu burada ihmal edildi. Ciinkii CO, su-gaz shift
reaksiyonuna (Dussan Reaksiyonu) katilir. Burada daha ¢ok CO’ya nispeten H; ve
COy, tretilir (Holtappels et al., 1999). Ayrica sadece H; yakithi yakit pili ile %25
CO- %75 H; yakit karisimli yakat pili arasinda performans farkliligi gériilmemistir
(Yakabe et al., 2001; Zhang et al., 2007).

Asagidaki Sekil 4.2 ve Sekil 4.3’te yakit pili dizini yapist ve kullanilan

malzemeler goriilmektedir:



Sizdirmazhk elemam

Gizenekli nikel
Anot
YSZ elektrolit

Katot
Sizdirmazhk elemam

Hiicre

Sizdirmazhk elemam

Gizenekli nikel
Anot

YS8Z elektrolit
Katot
Hiicre Sizdirmazhik elemam

Sekil 4.2 Yakat pili dizini yapist (Wen et al.,2002)
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Sekil 4.3 Yakat pili dizini bilesenleri (Wen et al.,2002)



Model asagidaki siirecleri igerir:

e Elektronik yiik dengesi (Ohm Kanunu)

e lyonik yiik dengesi (Ohm Kanunu)

e Butler-Volmer yiik transfer kinetikleri

e Gaz kanallarindaki akis dagilimi (Navier-Stokes)

e Gozenekli GDE’larindaki akis (Brinkman denklemleri)

e (Gaz kanallarindaki ve gozenekli elektrotlardaki gaz faz kiitle dengesi

(Maxwell-Stefan Diffusion and Convection)
4.3 Yiik Dengeleri

Anot ve katot akim besleyicilerindeki elektronik yiik dengesi su sekilde
verilir: (Kakag et al.,2007; Zhang et al.,2007; Bove et al.,2005)

V ) (_O-lV ¢e|ektronik ) = 0 (43)

Burada o1, akim besleyicisinin elektronik iletkenligini ve @, onic s

besleyicinin elektronik potansiyelini ifade eder. Benzer sekilde, iyonik iletkende

gecerli iyonik yiik denkligi;

V- (_szﬂyonik ) =0 (44)

seklindedir. Burada “o,” , iyonik iletkenlik ve “ @, ., 7, iyonik potansiyeldir.

Anot ve katot GDE’unda elektronlar, iyonik iletim elektrolit fazi ve
elektronik iletim fazi arasinda iletilir. Bu, yiik dengesi denklemlerinin akim kaynagi

terimlerini asagidaki gibi igerdigini gosterir: (Prinkey et al.,2004)

V- (_O-lv¢elektronik ) = Saiict

\& (_O-ngﬁiyonik ) = Saiict (45)

Burada “S,i,, 7, spesifik ylizey alani olan “S,” nimn yiik transfer yogunlugu

a’ict

olan “i, ” ile carpimiyla gosterilir.



Butler-Volmer yiik transfer kinetiklerinin, yiik transfer akim yogunlugunu
tanimladigin1 farz edelim. Anotta, hidrojen ve metan suya indirgenir ve asagidaki

yiik transfer kinetikleri denklemi su sekilde uygulanir:

o c, . 4c, 0,5F (—O,SF j
| = X,——+1, . X,,——| | eXP| —— —exXp| — 4.6
a,ct 0,a”*h2 C 0,a”*ch4 Cch4’ref (|: p( RT n p RT n ( )

h2,ref

Burada “i, , 7, anot degisen akim yogunlugu, (A/mz), “X., ", hidrojenin molar

2

kesri, “X,,”, metanin molar kesri, “ C; ”, tiirlerin toplam konsantrasyonu,
(mol/m®) ve Chorer + Conarer | » Teferans konsantrasyonudur (mol/m3). Ayrica “F”,

(1994}

Faraday sabiti (C/mol), “R”, gaz sabiti (J/(mol-K)), “T”, sicaklik (K), ve “n” asir1

gerilimdir (V).
Katot i¢in asagidaki bagint1 kullanilir:
. . 0,5F C -0,5F
Iy =iy | EXp| ——n |—X L—ex ’ 4.7
coot 0,c|: p( RT 77) 02 Conre p( RT ﬂﬂ (4.7)

2

Burada “ip¢”, katot degisim akim yogunlugu (A/m?%) ve “ X,,”, oksijen molar

kesridir.

Asir Gerilim su sekilde ifade edilir:

n= ¢elektronik _¢|yonik - A¢eq (48)
Burada

“Ad,,”, denge potansiyel farkidir (V).

Anodun giris sinirinda potansiyel, sifir referans potansiyeline sabitlenir.
Katodun giris sinirinda, potansiyel hiicre voltajina ayarlanir, “V¢”. Denklem ise

su sekildedir:

Vcell = A¢eq,c - A¢eq,a _Vpol (49)



Burada “V,”, polarizasyondur. Bu modelde, anot ve katot baslangi¢

ol >

voltajlart A,

eq,a

=0V ve Ag

eq,c

=0,95 V olarak kabul edilir. Yakit pili voltaj

araligmi (0,2V <V,

wr <0,9 ), parametrik ¢oziicii icin polarizasyon voltaj
araligini 0,05 V ve 0,85 V alarak modelin ¢oziimiine baslanir.

Iyonik yiik denge denklemleri icin, biitiin dis smirlara yalittm smir kosulu
uygulanir.

I¢ siirlarda ise, akimda ve potansiyelde siireklilik varsayilan olarak ayarlanir.

4.4 Cok Bilesenli Tasinim

KOYP bir¢ok farkli yakitlarda c¢alisabilir. Bu model dogalgaz ve hava
lizerinde calisan bir birimi tanimlar. Anotta yakit doniistiiriiciide doniistiirtilmiis
dogalgaz yakit olarak belirlenir. Burada dogalgaz bes bilesenden olusur: metan, su
buhari, hidrojen, karbon monoksit, karbon dioksit. Katotta ise oksijen ve nitrojen
gibi iki bilesenden olusan hava kabul edilir.

Modelimizde bilesen taginimi Maxwell-Stefan difiizyonu ve tasinim

bh)

denklemleri ile tanimlanir. i tiirlerinin agirhik oranlarmin  “@®,” olmasma izin

verelim. Sabit durumda kiitle dengesi su sekilde kullanilir: (Kakag et al.,2007)

k
V-{wipu —po, ) Dy [Mﬂ(woj +o, %}(xj - )@D =R (4.10)
j=1 p

i

Burada “ [_)ij ” Maxwell-Stefan dagilimindan elde edilen 6lgiilen ¢ok bilesenli
Fick diflizyonunun “ij ” bilesenini temsil ederken “p > akigkanin yogunlugunu,
“p” basinci ve “R;” i tiirleri i¢in tepki kaynak terimini ve “X;” j tirlerinin molar

kesrini temsil eder.

Fick diflizyonu, kinetik gaz teorisi temel alinarak su sekilde basitlestirilebilir

(Perry and Green, 2008):

1/2
TH® 1 1

D. =k——— | —+— 411

U] p(Vi1/3+V1/3 |:M| Mj:l ( )

j



Burada; k =3,16.10°m*/s olarak almir. “M.”, i tiirlerinin molar kiitlesini,
“M;”, j tirlerinin molar kiitlesini verir.

Molar difiizyon katsayisi ile Fuller metodu ile belirlenir (Poling et al., 1987):

0,00143T*"

=T PMZIEET .

Cizelge 4.1 Hiicre gazlar1 molar difiizyon hacimleri

Hiicre Gaz1 | Molar Difiizyon Hacmi (m?/s)
CH, 25,14x10°
H,0 13,1x10°
H, 6,12x10°
Co 18,0x10°
CO; 26,9x10°
0, 16,3x10°
N, 18,5x10°

Ortalama mol kiitlesi su sekilde olgiiliir:

M :szMj (4.13)

Gazin ideal bir gaz oldugunu varsayarsak bunun i¢in yogunluk su sekilde
verilir:

_ M

- 4.14
P="rT (4.14)



Acik kanallarda tepkime kaynagi terimi sifira ayarlanir. Ama GDE’larinda
kaynak terimi elektrokimyasal tepkime oraniyla verilir. Faraday’in kanununa gore,

yiik transfer akim yogunlugundan 6l¢iiliir:

ictil\/li
R =V, %
nF

(4.15)

Burada “V,”, stokiyometrik katsayidir ve “n,” tepkimedeki elektronlarin

sayisidir. Gozenekli elektrotlarda efektif difiizivite ise Bruggeman bagimtist ile

bulunur (Poling et al., 1987);

D, =D.é" (4.16)
Gaz kanallarinin duvarlarindaki ve GDE’undaki sinir kosullart “sifir kiitle
akimidir” (Yaliim durumu). Giriste, ¢ikis kosulu “konvektif akim” iken bilesim
tayin edilir. Bu varsayim ile konvektif terimi bu sinira dikey olarak taginim
oldugunu ifade eder.
Bilesimdeki ve akimdaki devamlilik GDE ve kanallar arasinda olan ara

yiizeylerindeki biitiin kiitle denklikleri i¢in uygulanir.

4.5 Gaz akis denklemleri
4.5.1 Acik hiicre kanallarinda akis

Zayifca sikistirilabilir Navier-Stokes denkligi acik kanallardaki akisi kapsar:
(Janardhanan and Deutschmann, 2006).

2

p(u-Vu =V-{—pl +y((Vu+(Vu)T)—§(V-u)Iﬂ

V-(pu)=0

(4.17)



Burada “ ¢ ” dinamik viskozitedir (Pa-s).

Gegirgen GDE’larinda , Brinkman denkligi akis hizini su sekilde tanimlar:

(ﬁ+qu :V~[—pl +§(Vu+(Vu)T —%(V-u)lﬂ

K

V-(pu)=Q

(4.18)

Burada “&” ve “K” sirasiyla ortamin gozenekliligi ve gegirgenligidir ve
“Q” , kitle kaynak terimidir ve bu yik akim yogunluguyla asagidaki gibi
iliskilidir: (Danilov et al.,2009).

ict,il\/li
Q ZiZSani—F (419)

Kimya miihendisligi modiiliinde, Brinkman denklemleri uygulama modu
Navier-Stokes uygulama modu ile birlestirilmistir. Burada tek bir uygulama modeli
kullanilabilir. Herhangi bir alt etki alaninda, serbest akis ve gozenekli bolge akist
arasindaki se¢im, “Subdomain Settings” diyalog kutusu i¢indeki “Flow in porous
media (Brinkman denklemleri)” kontrol kutusu ile yapilabilir. Gozenekli ve serbest

alt etki alanlarindaki biitiin sinirlar i¢ sinirlar gibi davranir.

Giriste ve ¢ikista, akiskan1 hareket ettirmek i¢in giriste ¢ikisa oranla hafif bir

basing farki belirlenir. (2 Pa anotta ve 4 Pa katotta).

4.5.2 Hiicre gazlar ve gaz karisimlar viskozite hesaplar:

Modelimizde bulunan gazlar karisim halindedir. Karisim gazlar1 viskozitesi
ise ¢ok farkli degiskenlere bagli olarak degisir. Viskozite hesabi i¢in burada saf
gazlarin karigiminda kullanilan Lucas metodu se¢ilmistir (Poling et al., 1987). Ayn

zamanda saf gazlarinda viskozitesi de bu yontemle hesaplanmistir.



vE =[0,807T. %% —0,357 exp(-0,449T)

(4.20)
+0,340exp(~4,058T, ) +0,018] F°F

Burada;

v, viskozite, (uP)

£, indirgenmis, ters viskozite, (uP)™

T, , indirgenmis sicaklik

Fs , kutupluluk etkisi katsayist

Fo , kuantum etkisi katsayisidur.
Burada ¢ ise;

1/6
Tc

£, indirgenmis, ters viskozite, (uP)™
T., kritik sicaklik, (K)

M, mol kiitlesi, (g/mol)
P., kritik basing, (bar)

ile ifade edilir.
Gaz karisimlarinda denklem bilesenleri ise s0yle hesaplanir:
T =2 YT (4.22)
T =2 YT, (4.23)

Z Vil

P, =RT, - (4.24)

Z ViV

M, => M, (4.25)

Fa = S YFS (4.26)



Fon = {Z Y, F&}A (4.27)

Burada karisim gazlari igin;

T_., kritik sicaklik, (K)

cm >

T

m?

indirgenmis sicaklik,

P, , kritik basing, (bar)

M, , mol kiitlesi, (g/mol)

Fo. , kutupluluk etkisi katsayist,

Fgm , kuantum etkisi katsayist,

A, kuantum diizeltme faktoridiir.

4.6 Model Parametreleri ve Kabuller

Modeldeki kat1 yakit oksit pili hiicre modeli diizlemsel, karsit akisli ve anot
destekli olarak belirlenmistir. Anot tarafinda akigskan olarak yakit donistiiriiciide
dontistiiriilmiis dogalgaz, katot tarafinda akigskan olarak hava kullanilmistir. Anot
akigskani hiicreye soldan, katot akiskani ise sagdan girmektedir. Kabul edilen anot
ve katot akigkanlar1 mol oranlart Cizelge 4.1 ve Cizelge 4.2°de belirtilmistir

(Danilov et al.,2009).

Cizelge 4.2 Anot tarafi gazlar1 mol oranlari

Anot tarafi gazlar1 | Mol orani

CH,4 0,171
H.O 0,493
H> 0,263
CO 0,029

CO, 0,044




Cizelge 4.3 Katot tarafi gazlari mol oranlari

Katot tarafi gazlar1 | Mol orani
02 0,21
N2 0,79

KOYP modelleri genellikle anot destekli, katot destekli ve elektrolit destekli
olarak ii¢ farkli bi¢imde tasarlanmaktadirlar. Burada 1000 °® C ve altinda ¢aligmaya
uygun olmasi agisindan elektrolit destekli tasarim disiintilmistiir (Kakag et al.,
2007). Anot ve katot gorece olarak ¢ok daha ince secilmistir. Kati oksitli yakit pili
model ¢izimi ve Olgiileri Sekil 4.4, Sekil 4.5 ve Sekil 4.6’de ayrintili bir bigimde
belirtilmistir.

Katot

Elektrolit

Anot

Sekil 4.4 Yakat pili hiicre modeli 6n goriiniis

Yakit pili hiicresinde ara baglantilari, anot, katot ve elektrolitin dis kisimlari
dis etkenlerden izole oldugu kabulii yapilmistir. Bilesenler arasi temas direnci

ihmal edilmistir.



Kanallardaki akis laminer ve sikistirllamaz olarak kabul edilmistir. Isinim

yoluyla 1s1 transferi ve kanallardaki yakit kacaklari ihmal edilmistir.

Sekil 4.5 Yakat pili hiicre modeli genel goriiniis dlgtiler

Sekil 4.6 Yakat pili hiicre modeli 6n goriiniis 6l¢iiler

Anot, katot ve elektrolitin fiziksel ve elektrokimyasal 6zellikleri Cizelge 4.3
ve Cizelge 4.4°de ayrintilar ile gosterilmistir (Holtappels et al., 1999; Huang et
al., 2008; Kakag et al., 2007).



Cizelge 4.4 Anot, katot ve elektrolitin fiziksel ve elektrokimyasal 6zellikleri

Hiicre Bileseni Ozellik Deger
Anot Malzeme Ni/YSZ
Elektriksel iletkenlik [S/m] G = 9’5T'107 exp(‘1T150)
Gegirgenlik [m°/Pa.s] 1,7.10™
Isil Tletkenlik [W/m.K] 6,2
Yogunluk [kg/m®] 6200
C, [kdrkg.K] 0,65
Gozeneklilik, € 0,4
Spesifik Yiizey Alani, 55
Sa_a[1/m]
Denge Voltaji, Ad,, , [V] 0
Degisken Akim Baslangic
Degeri, i,, [A/M] >300
Katot Malzeme Sr-dolgulu LaMnO3

Elektriksel iletkenlik [S/m] Gy = ZT'W exp(_lTZOO)
Gegirgenlik [m°/Pa.s] 1,7.10%
Is1l iletkenlik [W/m.K] 9,6
Yogunluk[kg/m’] 6000
C, [kI/kg.K] 0,9
Gozeneklilik, € 0,4
Spesifik Yiizey Alani, Sa a o5
[1/m]
Denge Voltaji, A¢eq,c [V] 0,85
Degisken Akim Baslangig 2000




Degeri, i, [A/m?]

Elektrolit Malzeme Y,03-dengeli ZrO,

Elektriksel Iletkenlik [S/m] O oot = 31 34.10° exp(—lOSOO)
Gegirgenlik [m?/Pa.s] -
Is1l Iletkenlik [W/m.K] 2,7
Yogunluk [kg/m®] 5560
Cp [kI/kg.K] 0,3

Ara Baglanti Malzeme LSC kapli Haynes 230 alagimli

celik
. . - 6 _1100

Elektriksel Iletkenlik [S/m] O ara vagian = 9 3-10 exp(T)
Isil iletkenlik [W/m.K] 9,6
Yogunluk [kg/m®] 7700
Cp [kI/kg.K] 0,8

4.7 Grafiksel Kullanici Arabirimini Kullanarak Modelleme

4.7.1. Coziim basamaklar:

1.“COMSOL Multiphysics” baglatilir.

2.“Model Navigator” icinden “Space dimension “ listesinden 3D segilir.
3.“COMSOL Multiphysics>Electromagnetics>Conductive Media DC”

segilir.

4.“Dependent variables” alaninin i¢ine “ phi_electronic” yazilir.

5.“Application mode name” alani igine “electronic” yazilir.

6. “Multiphysics” butonuna tiklanir sonra “Add” e tiklanir.

7.Uygulama modu segilir:

“COMSOL Multiphysics> Electromagnetics > Conductive Media DC”

8.“Dependent variables” alaninin igine “phi_ionic” yazilir.

9.“Application mode name” alaninin i¢ine “ionic” yazilir.

10. “Add” e tiklanir.




11. Uygulama modu segilir. “Chemical Engineering Module>Mass
Transport>Maxwell-Stefan Diffusion and Convection”. (chms-katot)

12. “Dependent variables” alanina “w6 w7” yazilir. (O, N)

13. “Add” e tiklanir.

14. Uygulama modu segilir. “Chemical Engineering Module>Mass
Transport>Maxwell-Stefan Diffusion and Convection. (chms2-anot)

15. Dependent variables” alani i¢ine “w1 w2 w3 w4 w5” yazilir..

(CHg4, H20, Hy, CO, COy)

16. “Add” e tiklanir.

17. Uygulama modu secilir. “Chemical Engineering Module > Flow with
Variable Density > Weakly Compressible Momentum Transport >
Weakly Compressible Navier-Stokes”.

18. “Add” e tiklanir.

19. “Add Geometry” e tiklanir.

20. Select” 2D” segilir ve “OK” e tiklanir.

21. “Model Navigator” 1 kapatmak i¢in “OK” e tiklanir ve grafiksel kullanici

arabirimi baslatilir.

4.7.2 Geometrik modelleme

Bu modelde ilk olarak hiicrenin 2 boyutlu (2D) kesiti yaratilir. Sonra 2D agi
kurulur ve 3D geometri modeli ve ag1 yaratilir. Bu teknik, 6zellikle, uzatilmis bir
nesneye sahip olundugu durumlarda, uzun boyutta birka¢ ag tabakasia ayrilmak

istendiginde son derece kullanighdir.

4.7.3 iki boyutlu (2D) Kesiti

1.Meniiden “Draw>Specify Objects>Rectangle/Square” secilir.
2.“Width” alanina “10e-4“ ve “Height” alanina “5e-6" yazarak boyutlar
belirtilir, “OK?” e tiklanir.

3. Ana araglar meniisiinden “Zoom Extents” butonuna tiklanir.



4.Secili dikdortgeni (R1) kopyalamak icin “Ctrl + C” ye ve yapistirmak igin
“Ctrl + V” ye basilir.

5.“Displacement”  alaninda “y” bdliimiine *“-23e-6* yazilir. lkinci bir
dikdortgen (R2) yaratmak i¢in “OK” e tiklanir.

6.“Meniiden “Draw>Specify Objects>Rectangle/Square” segilir.

7.Width: 10e-4, Height: 18e-6, Base: Corner, x:0, y: -18e-6.” OK” e
tiklanarak nesne R3 olusturulur.

8.Diger dikdortgen su sekilde olusturulur (R4): Width: 5e-4, Height: 4e-4,
Base: Corner, X: 2,5e-4, y: 5e-6.” OK” e tiklanir.

9.“R4” secilerek kopyalanip yapistirilir.

10. “y” alan1 su sekilde belirtilir: -4.28e-4, sonra “OK” e tiklanir. (Nesne
R5 olusturulur).

11. Bagka bir dikdortgen su sekilde belirtilir(R6): Width: 10e-4, Height:
10,28e-4, Base: Corner, x: 0, y: -5,23e-6. ” OK” e tiklanir.

12. Baska bir dikdortgen (R7) su detaylarla yaratilir: Width: 5e-4, Height: le-
4, Base: Corner, X: 2,5e-4, y: 4,05e-4.

13. R7 dikdortgeni secilerek, kopyalanip yapistirilir.

14. “y” alam “-9,28e-4” yazilarak belirtilir. ” OK” e tiklanir ve R8 dikdortgeni
olusturulmus olur.

15. Cizim alanma geometriyi oturtmak i¢in ana araglar meniisiinden “Zoom

Extents” butonuna tiklayin.

Bu islemle 3 boyutlu geometrinin 2 boyutlu kesiti tamamlanir. Geometri

simdi asagidaki sekle benzemis olmalidir:
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Sekil 4.7 KOYP hiicre modeli 2D goriiniisii

4.7.4 Ag ve uzatilmis Ag

Simdi kesit i¢in bir yapilandirilmis ag yaratilir ve sonra bu ag, uzatilmis ag
tizerinde bir 3D geometri yaratmak i¢in uzatilir.

1. Su menii 6geleri segilir: “Mesh>Mapped Mesh Parameters”.

2.“Boundary” sekmesine tiklanir ve “Boundary 5 segilir (orta
katmanin kenart).

3.“Constrained edge element distribution” onay kutusu secilir ve “Number
of edge elements” alanina “1” yazilir.

4.Swmurlar 14, 15, 17, ve 20 olarak segilir.

5.“Constrained edge element distribution” onay kutusu segilir ve “Number
of edge elements” alanina “3” yazilir.

6.Benzer sekilde, 1 eleman elde etmek icin smirlar “12” ve “19” olarak
belirlenir.

7.Son olarak, 1 eleman daha elde etmek ic¢in smirlar 4, 10, 25, ve 27 olarak
sinirlanir.

8. Ag1 meydana getirmek i¢in “Remesh” e tiklanir ve sonra ” OK” e tiklanir.

Ag, simdi asagidaki sekle benzemis olmalidir:
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Sekil 4.8 KOYP hiicre modeli 2D ag goriiniimii
Ag1 uzatmadan Oonce 2 boyutlu ¢alisma diizlemini su sekilde tanimlamaniz
gerekir:

1.Menii 6gelerinden sunlar segilir: “Draw>Work-Plane Settings”. “Quick”
sayfasi lizerinde “y-z” diizlemi segilir ve “x” alanindaki varsayilan deger
“0” birakilir. ” OK” e tiklanir.

2.Menii 6gelerinden sunlar segilir: “Mesh>Extrude Mesh”.

3.“Distance” alanina “10e-3” yazilir.

4.“Mesh”.sayfas1 lizerinde “Number of element layers”, “10e-3” olarak
belirtilir. ” OK” e tiklanir

Simdi asagidaki sekil elde edilmis olunmalidir:
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Sekil 4.9 KOYP hiicre modeli 3D ag goriiniimii

4.7.5 Secenekler ve ayarlar

Kullanic1 ara birimine sabitler ve skaler ifadeleri aktarmak icin asagidaki
adimlar uygulanir:
1.“Options” mentiisiinden “Constants” iletisim kutusu agilir.
2. Cizelge 4.5 te bulunan sabit degerleri girilir. “OK” e tiklanir.
3.“Scalar Expressions” iletisim kutusunu agmak i¢in sunlar segilir:
“Options>Expressions>Scalar Expressions”.
4. Cizelge 4.6’te bulunan skaler ifadeler girilir. “OK” e basilir.
5.“Options” meniisiinden “Expressions>Subdomain Expressions” seg¢ilir
6. Alt etki alani ifadeleri asagidaki Cizelge 4.7’ye uygun olarak tamimlanir. Ug

ifadenin her birinin ayr1 satirda girilmesine dikkat edilmelidir.

Cizelge 4.5 Sabitler

Isim ifade Aciklama

F 96500[C/mol] Faraday sabiti




Atmosfer

p_atm 1[atm] basmnet
T 1000[K] Sicaklik
Rg 8,314 [J/(mol*K)] Gaz sabiti
mu 3e-5 [Pa*s] viskozite, hava
Anot giris
dp_a 2 [Pa] basinci
Katot giris
dp_c 4 [Pa] basinci
io a 5300 [A/m"2] Anotik degisken
akim
. Katodik
N
io_c 2000 [A/m"2] degisken akim
A e
5e5 [1/m] yueey
Sa_c 1e5 [1/m] Katot spesifik
yiizey alani
V_pol 0,05 [V] Baslaqglg hiicre
polarizasyonu
1,76e-11 [m"2]
Anot
perm_a . oo
gecirgenligi
perm_c 1.76e-11 [m"2] Katot e
gecirgenligi
. Anot denge
dphieq_a 0[V] voltait
dphieq_c 0,85 [V]

Katot denge




voltaji

kleff_a

3,34e4*exp(-10300/T[L/K]) [S/m]

Anot elektrolit
efektif

iletkenligi

kleff ¢

3,34e4*exp(-10300/T[1/K]) [S/m]

Katot elektrolit
efektif
iletkenligi

kseff_a

(9,5e7/T[1/K])*exp(-1150/T[L/K]) [S/m]

Anot kati
efektif

iletkenligi

kseff ¢

(4,27 T[L/K])*exp(-1200/T[1/K]) [S/m]

Katot kat1
efektif
iletkenligi

Kl

3,34e4*exp(-10300/T[1/K]) [S/m]

Elektrolit
iletkenligi

ks

(9,3e6/T[L/K])*exp(-1100/T[1/K]) [S/m]

Akim toplayict
iletkenligi

vch4

25,14e-6

Atomik
Difilizyon
Hacmi, CH4

vh20

13,1e-6

Atomik
Difilizyon
Hacmi, H20

vh2

6,12e-6

Atomik
Difiizyon
Hacmi, H2

VCO

18e-6

Atomik
Difiizyon
Hacmi, CO

vCco2

26,9e-6

Atomik
Difiizyon
Hacmi, CO2




Atomik

V02 16,3e-6 Difiizyon
Hacmi, O2
Atomik
vn2 18,5e-6 Difiizyon
Hacmi, N2
Mch4 16,043 [g/mol] Moty it
Mh20 18 [g/mol] Moﬁrzlgﬁﬂe’
Mh2 2 [g/mol] Molar kiitle, H2
Mco 28,01 [g/mol] Molar kiitle, CO
Mco2 44,01 [g/mol] M"lérokzﬁﬂe’
Mo2 32 [g/mol] Molar kiitle, 02
Mn2 28 [g/mol] Molar kiitle, N2
kd 3,16e-8 [MA2/s] gﬁiﬂ:‘t‘z
e_por 0,4 Gozeneklilik
mu_ch4 2,72e-5 Viskozite,CH4
mu_h20 3,31e-5 Viskozite,H20
mu_h2 1,91e-5 Viskozite, H2
mu_co 4,01e-5 Viskozite,CO
mu_co2 4,14e-5 Viskozite,CO2
mu_o2 2,05e-5 Viskozite,02




mu_n2

1,79e-5

Viskozite,N2

mu_anot

1,68e-5

Viskozite, Anot

mu_katot

3,98e-5

Viskozite, Katot

Dch4h2o

kd*(T[1/K])"1,75/(p_atm[1/Pa]*(vch4™(1/
3)+
vh20"(1/3))"2)*(1[kg/mol]/Mch4+1[kg/m
ol]/ Mh20)"0,5

Diflizivite

Dch4h2

kd*(T[1/K])"1,75/(p_atm[1/Pa]*(vch4™N(1/
3)+vh2/(1/3))"2)*(1[kg/mol]/Mch4+1[kg/
mol]/Mh2)~0,5

Difuzivite

Dch4co

kd*(T[1/K])"1,75/(p_atm[1/Pa]*(vch4™N(1/
3)+vco”™(1/3))*2)*(1[kg/mol]/Mch4+1[kg/
mol]/Mco)"0,5

Difiizivite

Dch4co?2

kd*(T[L/K])"1,75/(p_atm[1/Pa]*(vcha™N(1/
3)+vco2/\(1/3))2)*(1[kg/mol]/Mch4+1[kg
/mol]/Mco2)"0,5

Difuzivite

Dh2oh2

kd*(T[1/K])"1,75/(p_atm[1/Pa]*(vh20™(1/
3)+vh2/(1/3))2)*(1[kg/mol]/Mh2o+1[kg/
mol]/Mh2)"0,5

Difiizivite

Dh2oco

kd*(T[1/K])"1,75/(p_atm[1/Pa]*(vh20™(1/
3)+vco™(1/3))"2)*(1[kg/mol}/Mh2o+1[kg/
mol]/Mco)"0,5

Difiizivite

Dh2oco2

kd*(T[1/K])"1,75/(p_atm[1/Pa]*(vh20™(1/
3)+
vco2/(1/3))2)*(1[kg/mol]/Mh20o+1[kg/m
ol]/Mco2)"0,5

Difiizivite

Dh2co

kd*(T[1/K]"1,75/(p_atm[1/Pa]*(vh2(1/3
)+vcor

(2/3))"2)*(1[kg/mol}/Mh2+1[kg/mol]/Mc
0)" 0,5

Difiizivite

Dh2co2

kd*(T[L/K])L, 75/(p_atm[L/Pa]*(vh2(1/3
)+vCo2(1/3))"2)

Difuzivite




*(1[kg/mol]/Mh2+1[kg/mol]/Mc02)"0,5

kd*(T[L/K]"1,75/(p_atm[1/Pa]*(vco™(1/3

Dcoco2 )+vco2/(1/3))2)*(1[kg/mol]/Mco+1[kg/ Difiizivite
mol]/Mco02)"0,5
kd*(T[1/K]D"1,75/(p_atm[1/Pa]*(vo2~(1/3
Do2n2 )+vn27(1/3))2)*(1[kg/mol]/Mo2+1[kg/m Diflizivite
ol]/Mn2)"0,5
Dch4h2oeff Dch4h2o0*e_por™1,5 Difiizivite
Dch4h2eff Dch4h2*e_por™1,5 Difiizivite
Dch4coeff Dch4co*e_port*1,5 Diflizivite
Dch4co2eff Dch4co2*e_por™1,5 Difiizivite
Dh2oh2eff Dh2oh2*e_por"1,5 Difiizivite
Dh2ocoeff Dh2oco*e_por™1,5 Diflizivite
Dh2oco2eff Dh2oco2*e_por*1,5 Difiizivite
Dh2coeff Dh2co*e_por~1,5 Diflizivite
Dh2co2eff Dh2co2*e_por~1,5 Difiizivite
Dcocozeff Dcoco2*e_por*l,5 Difiizivite
Do2n2eff Do2n2*e_por*1,5 Difiizivite
x_ch4 0,171 gﬁg’lﬁz
x_h20 0,493 grgg%zo(l)
x_h2 0,263 glrr;fnl\ﬁl"zl
X_CO0 0,029

Giris Mol




Oran1,CO

Giris Mol
X_co02 0,044 Oran1,CO2
Giris Mol
X_02 0.21 Oran1,02
Giris Mol
X_n2 0,79 Orani1,N2
Giris Agirhik
*
w_ch4ref X_ch4*Mch4/M_anot Orant,CH4
Giris Agirhik
*
w_h2oref Xx_h20*Mh20/M_anot Orant,120
Giris Agirhik
*
w_h2ref x_h2*Mh2/M_anot Orant,H2
Giris Agirlik
*
w_coref X_co*Mco/M_anot Orant,CO
Girig Agirhik
*
w_coZ2ref X_C02*Mco2/M_anot Orant,CO2
w_o2ref X_02*Mo02/M_katot Giris Agirhik
Oran1,02
Girig Agirhik
w_n2ref X_Nn2*Mn2/M_Kkatot
Orani,N2
M anot X_ch4*Mch4+x_h20*Mh20+x_h2*Mh2+ Anot Gazlari
- X_C0* Mco+x_co2*Mco2 Mol Kiitlesi
M_ katot X_02*Mo02+x_n2*Mn2 Katot Gazlan

Mol Kiitlesi




Toplam molar

*
¢_tot p_atm/(Rg*T) konsantrasyon
¢ horef c_tot*(w_h2ref/Mh2)/(w_h2ref/Mh2+w_c H2 referans
- h4ref/Mch4+ w_h2oref/Mh20) konsantrasyonu
c o2ref c_tot*(w_o2ref/Mo2)/(w_o2ref/Mo2+w_n 02 referans
- 2ref/Mn2) konsantrasyonu
Cizelge 4.6 Skaler ifadeler
Isim ifade Aciklama
io_c*(exp(0,5*F*eta/(Rg*T))- .
ict ¢ X_W6_chms*(c_tot/c_o2ref)*exp(- Katot yiik
0,5*F*eta/(Rg*T))) [ A/mz] transfer akimi
i0_a*x_w3_chms2*(c_tot/c_h2ref)*(exp(0,5* Anot viik
ict_a F*eta/(Rg*T))-exp(-0,5*F*eta/(Rg*T))) yu
[ A/mz] transfer akimi
o a p/(Rg*T)*(x_w6_chms*Mo2+x_w7_chms*M Anot gaz
— n2) [kg/m?] yogunlugu
p/(Rg*T)*(x_wl_chms2*Mch4+x_w2_chms Katot 0az
rho_c | 2*Mh2o+x_w3_chms2*Mh2+x_w4_chms2* 3 nlg 9
Mco+x_w5_chms2*Mco2) [kg/m®] yoguniugu
V_cell dphieg_c-dphieq_a-V_pol [V] Hiicre voltaji
P_out j_ec*V _cell
- - ~cell TW] Toplam ¢ikis




glcu

Cizelge 4.7 Alt etki alan1 ifadeleri

I[sim Alt etki alan1 2 Alt etki alan1 4 | Alt etki alam1 7| Alt etki alan1 8

ota phi_electronic- phi_electronic-

phi_ionic-dphieq_a phi_ionic-dphieg_c
rho rho_a rho_c rho_a rho_c
ict ict a ict ¢

7.Sunlar segilir:
“Options>Integration Coupling Variables>Boundary Variables”.
8. Smur “9” secilir ve asagidaki tabloya gore arabirimin ylizey alani igin bir

birlesim degiskeni belirtilir. Sonra ” OK” e tiklanir.

Cizelge 4.8 Sinir birlesim degiskeni

Isim [fade Birlesim Derecesi Genel Yer

A 1 4 Evet

9. Sunlar segilir:
Options>Integration Coupling Variables>Subdomain Variables.
10. Smur “2” (anot GDE) segilir. ve asagidaki tabloya gore bir birlesim
degiskeni belirtilir. Yapildiginda ” OK” e tiklanir.

Cizelge 4.9 Alt etki alan1 birlesim degiskeni

Isim Ifade Birlesim Derecesi Genel Yer

j_ec ict*Sa_a/A 4 Evet




Elektrokimyasal akim yogunlugunu veren bu ifade, ylik dengesindeki kaynak

terimine tekabul eder.

4.7.6 Alt etki alam ayarlari — Iletken ortam DC (Elektronik)

1. Sunlar segilir: “Multiphysics>Conductive Media DC (electronic)”.

2. Sonra “Physics>Subdomain Settings” secilir.

3. Alt etki alanlar1 agsagidaki cizelgeye gore belirlenir:

Cizelge 4.10 Elektronik alt etki alan1 ayarlari

) Alt etki Alt etki
Alt etki
alanlar1 alanlar1  |Alt etki alam
alanlari Alt etki alan1 4
Avyarlar 1,6,10 509,11 2
3,7, 8 (Katot GDE)
(Anot Ara | (Katot Ara |(Anot GDE)
Baglanti) Baglant1)
Aktif Hay1r Evet Evet Evet Evet
o ks ks kseff_a kseff ¢
Qj 0 0 -Sa_a*ict -Sa_c*ict

4. Alt etki alan1 “4” secilir. “Init” sayfasinda “phi_electronic(tp)”

kismina

“dphieq_c-dphieq_a-V_pol” yazilir. Boylece elektronik potansiyel igin

baslangi¢ degeri verilmis olur.

5.“Element” sayfasinda biitiin alt etki alanlar1 secilir ve “Predefined

Elements” listesinden ““ Lagrange-Linear” segilir.

6.“OK” e tiklanir.

Burada elektrik iletkenliginin yiiksek ve gradyenlerin kiiciik olmasi

dolayisiyla, dogrusal 6geler kullanilmistir. Ayrica ¢6zliim sirasinda daha az

hafizaya gereksinim duyulur.

4.7.7 Smr kosullar ayarlar - Iletken ortam DC (Elektronik)



1. Sunlar secilir: “Physics>Boundary Settings”
2.Bir smir secilip “Ctrl + A” ya basarak biitiin sinirlar segilir ve “Boundary
condition” listesinden “Electric insulation” secilerek uygulanir.
3.Smirlar “1,17,31”  segilir (anot girisindeki ara baglant). “Boundary
condition” listesinden  “Ground” durumu secilir. Bu sifir potansiyel

anlamina gelir.

4.Sinirlar “50,54,56; secilir (katot girisindeki ara baglant1) ve “Electric
potential” kosulu uygulanir.
5.%“Vy” alanina “V_cell” yazilir ve ” OK” e tiklanir. Bu hiicre voltajimin bu

siirda kullanildig1 anlamina gelir.
4.7.8 Alt etki alam ayarlar1 — iletken ortam DC (Iyonik)
1. “ Multiphysics>Conductive Media DC (ionic)” segilir.

2. Sunlari se¢in: “Physics>Subdomain Settings”.

3. Ayarlar agagidaki tabloya gore belirtilir. Yapildiginda ” OK” e tiklanir.

Cizelge 4.11 Iyonik alt etki alan1 ayarlart

Alt etki alanlar1| Alt etki alam1 | Alt etki alan1 | Alt etki alan1
Avyarlar 1, 5-11; 2 3 4
(Anot kat) (Elektrolit) (Katot kat1)
Aktif Hayir Evet Evet Evet
o Kleff_a Kl Kleff ¢
Qj Sa_a*ict 0 Sa_c*ict

4.7.9 Simir kosullar1 ayarlari — Iletken ortam DC (Iyonik)

Biitlin dis sinurlar i¢in varsayilan siir kosulu “Toprak™tir. Asagidaki adimlar

izlenerek bu ayar sifir iyonik akim olarak degistirilir.



1. Sunlar se¢in: “Physics>Boundary Settings”.
2. Bir smur secip “Ctrl + A” ya basarak tiim sinirlar segilir.
3.“Boundary condition” listesinden “Electric insulation” segilir. ” OK” e

tiklanir.

4.7.10 Alt etki alan1 Ayarlari - Zayifca sikistirilabilir Navier-Stokes

1. “Multiphysics>Weakly Compressible Navier-Stokes (chns)” se¢ilir.
2. Sunlar secilir: “Physics>Subdomain Settings”.

3. Alt etki alan1 ayarlar1 agagidaki tabloya gore girilir:

Cizelge 4.12 Navier-Stokes alt etki alan1 ayarlar1

Alt etki alanlari Alt etki alanlari Alt etki alanlari
Avyarlar
1,3,5,6,9,10,11; 2, 7; 4, 8:;
Aktif Hayir Evet Evet
p rho_a rho_c
n mu_anot mu_katot

4. Sinirlar “2, 4, 7,8” se¢ilir ve “Stabilization” sekmesine tiklanir.

5. “Streamline diffusion (GLS)” ve “Crosswind diffusion” onay kutular1
temizlenir.

6. “Init” sekmesine gidilir ve “p(tp)” alanina “p_atm” yazilir.

7. “Physics” sayfasina geri doniiliir ve alt etki alanlar1 “2 ve 4” segilir.




8. “Flow in porous media (Brinkman equations)” onay kutusu segcilir ve
“Porosity” alanina “e_por” yazilir.

9. Asagidaki ayarlar belirtilerek ” OK” e tiklanir.

Cizelge 4.13 Gozenekli bolge alt etki alan1 ayarlar1

Avyarlar Alt etki alani1 2 Alt etki alan1 4
K perm_a perm_c
Q Sa_a*ict*((Mh20+Mco-Mh2- Sa_c*ict*Mo2/(4*F)
Mco2)/(2*F)+(Mch4-
Mh20)/(8*F))

4.7.11 Sir kosullar ayarlari - Zayifca sikistirilabilir Navier-Stokes

1. “Physics>Boundary Settings” segilir.

2. Sinir “53” (katot girisi) secilir. “Boundary type” kismi “Stress” olarak ve

“Boundary condition” kismi “Normal stress, normal flow” olarak

belirtilir. “fy” alanina “p_atm+dp c” yazilir. Bu sayede giriste basing farki

yaratilmig olur ve kanal i¢inde akis saglanir.

3. Swur “20” (anot girisi) secilir. “Boundary type” kismi “Stress” olarak ve

“Boundary condition” kismi “Normal stress, normal flow” olarak

belirtilir. “fy” kismu “p_atm+dp a” olarak ayarlanir. Ayni sekilde anot

tarafinda da basing farki olusturulmus olur.

4. Smir “24” (katot cikisi); 52 (anot ¢ikis1)” secilir. “Boundary type” kismi

“Outlet” olarak ve “Boundary condition” kism1 “Normal stress” olarak

belirtilir. “fy” kism1 “p_atm” olarak ayarlanir.

5. ” OK” e tiklanir.



4.7.12 Alt etki alam ayarlar1 - Maxwell-Stefan dagilimi ve tasiimi
(chms) (Katot)

1. “Multiphysics> Maxwell-Stefan Diffusion and Convection (chms)”
secilir.

2. “Physics>Properties” segilir ve “Equation form” kismi “Conservative”
olarak ayarlanir. “OK?” e tiklanir.

3. “Physics>Subdomain Settings” segilir.

4. Biitlin alt etki alanlar1 segilir ve “Active in this domain” onay kutusu
temizlenerek “application mode” etkisiz hale getirilir.

5. Daha sonra su alt etki alanlar secilir: “4 (katot)” ve “8 (katot akis kanal1)”.
Sonra “Active in this domain” onay kutusu segilir.

6. iki etkin alt etki alan1 icin asagidaki ayarlar belirtilir:

Cizelge 4.14 Yogunluk, sicaklik, basing ve hiz ayarlar1 (Aktif simir 4 ve 8)

Ozellik Simge Ifade
Yogunluk p rho_c
Basing p p
Sicaklik T T
Hiz u,v,w uv,w

7.Alt etki alan1 “4 (katot)” se¢ilir ve “Edit” butonuna tiklanir. Yayilma hizi
matrisi diizenlenir ve sabitlerin (Do2n2eff) matris konumlar1 asagidaki gibi

olur.

Maxwell-Stefan diffusion coefficients l&J

1 Do2n2eff

1

OK H Cancel 1




Sekil 4.10 Maxwell-Stefan katot efektif dagilim katsayilart

8. Alt etki alanm1 “8 (katot akis kanal1)” segilir ve “Edit”e tiklanir. Yayilma hiz1
matrisi diizenlenir ve katot akis kanalinda sabitlerin (D02n2) matris

konumlar1 asagidaki gibi olur.

Maxwell-Stefan diffusion coefficients Léj

Do2n2

[ OK }{ Cancel ]

Sekil 4.11 Maxwell-Stefan katot akis kanali dagilim katsayilart

9. Alt etki alanlar1 “4 (katot)” ve “8 (katot akis kanal1)” se¢ilir.

10. “w6” sayfasinda, “Molecular weight” alanina “Mo2” yazilir.

11. “w7” sayfasinda, “Molecular weight” alanina “Mn2” yazilir.

12. “Init” sekmesine tiklanir. “w6(tp)” kismi1 “w_o2ref” olarak girilir.

13. Alt etki alan1 “4 (katot)” secilir ve “R” alanina “Sa_c*ict_c*Mo2/(4*F)”

yazilir ve ” OK” e tiklanir.

4.7.13 Simir kosullar: ayarlar: - Maxwell-Stefan dagilim ve

tasimimi (chms) (Katot)

1. “Physics>Boundary Settings” secilir.

2. Katot giris sinirinda (53), “w6” icin “Boundary condition* olarak “Mass
fraction” segilir. “Mass fraction” degeri “w_o2ref” ile belirtilir.

3. Katot ¢ikisinda (24), “w6” i¢in “Convective flux” segilir.

4.” OK” e tiklanir.



4.7.14 Alt etki alam ayarlar1 - Maxwell-Stefan dagilimi ve tasiimi
(chms2) (Anot)

1. “Multiphysics>Maxwell-Stefan Diffusion and Convection (chms2)”
segilir.

2. Sunlar segilir: Physics>Properties. “Application Mode Properties”
iletisim kutusu i¢inde “Equation form” kismi “Conservative” olarak
ayarlanir. “OK?” e tiklanir.

3. “Physics>Subdomain Settings” secilir.

4. Biitlin alt etki alanlar1 secilir ve “Active in this domain” onay kutusu
temizlenerek “application mode” etkisiz hale getirilir.

5. Alt etki alanlar1 “2 (anot)” ve “7 (anot akis kanal1)” se¢ilir. “Active in this
domain” onay kutusu segilir.

6. Alt etki alam1 “2 (anot)” segilir. “General” sayfasinda “Dch4h2oeff,
Dch4h2eff, Dch4coeff, Dch4co2eff, Dh2oh2eff, Dh2ocoeff, Dh2oco2eff,
Dh2coeff, Dh2co2eff, Dcoco2eff” degerlerini yazmak i¢in “Edit”

butonuna tiklanir. Sonra “OK?” e tiklanir.

Maxwell-Stefan diffusion coefficients =)
pchah2oeff Dch4h2eff Dch4coeff Dché4co2eff
1 Dh2oh2eff Dh2ocoeff Dh2oco2eff

Dh2coeff Dh2co2eff
1 Dcoco2eff

Cancel

Sekil 4.12 Maxwell-Stefan anot efektif dagilim katsayilar

7. Alt etki alanlar1 “7 (anot akis kanal1)” secilir. “Dch4h2o0, Dch4h2, Dch4co,
Dch4co2, Dh2oh2, Dh2oco, Dh2oco2, Dh2co, Dh2co2, Dcoco2”

degerlerini girmek i¢in ayn1 adimlar tekrarlanir.



r 3
Maxwell-Stefan diffusion coefficients &J
Dch4h2o Dch4h2 Dch4co Dch4co2
1 Dh2oh2 Dh2oco Dh2oco2
1 Dh2co Dh2co2
1 Dcoco2

Sekil 4.13 Maxwell-Stefan anot akis kanali dagilim katsayilari

8. Alt etki alanlarinin ikisi de “2 (anot)” ve “7 (anot akis kanal1)” segilir ve

asagidaki ozellikler belirtilir:

Cizelge 4.15 Yogunluk, sicaklik, basing ve hiz ayarlar1 (Aktif sinir 2 ve 7)

Ozellik Simge Ifade
Yogunluk p rho_a
Basing p P
Sicaklik T T
Hiz u,v,w u, v, w

9. “wl1” sayfasinda mol kiitlesi olarak “Mch4”;
“w2” sayfasinda mol kiitlesi olarak “Mh20”*;
“w3 sayfasinda mol kiitlesi olarak “Mh2”;
“w4” sayfasinda mol kiitlesi olarak “Mco”;

“w5” sayfasinda mol kiitlesi olarak “Mco2” olarak yazilir.

10. “Init” bolimiinde w1(t0) kismina “w_ch4ref”;
“Init” bolimiinde w2(t0) kismina “w_h2oref”;
“Init” boliimiinde w3(t0) kismina “w_h2ref”;

“Init” boliimiinde w4(t0) kismina “w_coref” olarak yazilir.

11. “w3” sayfasinda alt etki alan1 “2 (anot)” secilir ve “R” alanina

“-Sa_a*ict a*Mh2/(2*F) yazilir.



“w1” sayfasinda ise “R” alanina, ““ -Sa_a*ict a*Mch4/(8*F)” ;
“w4” sayfasinda ise “R” alanina, “-Sa_a*ict a*Mco/(2*F)” yazilir. “OK”

e tiklanir.

4.7.15 Smr kosullar1 ayarlar1 - Maxwell-Stefan dagilimi ve tasimim
(chms2) (Anot)

4.
S.

6

. “Physics>Boundary Settings” secilir.

. Anot giris sinirinda smir kosulu “20”i¢in  “Mass fraction™ durumu segilir

Ve,

“wly” alanina “w_chdref”
“w2,” alanina “w_h2oref”
“w3(” alanina “w_h2ref”

“w4y” alanina “w_coref” yazilir.

. Anot ¢ikis smirinda sinir kosulu “52” igin “Convective flux” durumu

secilir.

. “OK” e tiklanur.

4.7.16 Coziim ve grafik analizleri

. “Solve” meniisiinden “Solver Parameters” secilir.
. “Solver” listesinden “Parametric” segilir.

. “Parameters” alaninda “Parameter names” kism1 “V_pol”, “Parameter

values” kismi1 “0.05 range (0.1,0.1,0.8)” olarak belirtilir.
“Linear system solver” listesinden “Direct (PARDISO)” segilir.
”OK?” e tiklanir.

. Modeli ¢6zmek igin “Solve” diigmesine basilir.

4.7.17 Son islemler ve gorsellestirme



0,5V hiicre voltajinda katot i¢indeki hidrojen (H) dagilimini gérmek i¢in su
adimlar uygulanmalidir:
1. Menii 6gelerinden “Postprocessing>Plot parameters” secilir.
2. “General” sayfasinda “Parameter value” listesinden “0.5” segilir.
3. “Slice” sayfasinda “X levels” ve “y levels” alanlarina sirasiyla “6” ve “1”
yazilir.
4. “Predefined quantities” listesinden “Mass fraction, w3 segilir.

5. Sekil 4.12” deki ¢izimi meydana getirmek i¢in “Apply”e tiklanir.

x 123

Sekil 4.14 Anottaki Hp (w3) dagilimi

Anottaki CH4, H,O, CO, CO, ve katottaki O,, N, dagilimlarinin

grafiklerini gérmek icin islemler aynm sekilde uygulanir.

x1=3

Sekil 4.15 Anottaki CH, (w1) dagilimi



V_pokB)e0S _ Slice: Maas fraction, w2

Mn:05%

Sekil 4.16 Anottaki H,O (w2) dagilimi

Sioe: Mas fracion, wh

V_pok6)e 03

Mi: 0.804

Sekil 4.17 Anottaki CO (w2) dagilimi

Sekil 4.18 Anottaki CO, (w5) dagilimi



Slios: Mazs fracion, wh.

i

Sekil 4.19 Katottaki O, (w6) dagilimt

Sloe: Mazs fracion, w7

6105

i

Sekil 4.20 Katottaki N, (w7) dagilimi

V_pok6)=05 _ Silce: Vekoalty fdd [ms]

Sekil 4.21 Anot ve katottaki hiz dagilimi



KOYP i¢in bir polarizasyon egrisi meydana getirmek i¢in asagidaki adimlar

izlenir:

. Sunlar segilir: “Postprocessing>Domain Plot Parameters”.

. “General” sayfasinda “Solutions to use” listesinden biitiin ¢6ziimler segilir.
. “Point” sayfasinda “Expression” alanina “V_cell” yazilir.

. Herhangi bir nokta segilir. Ornegin, “Point 1”.

. “x axis data” alaninda ilk olarak asagidaki butonuna “Expression” tiklanir.

o 01~ W

. “x-Axis Data” iletisim kutusunda “Expression” alanina “j ec” yazilir.
”OK” e tiklanir.

7. Cizimi meydana getirmek i¢in ”OK” e tiklanir ve “Domain Plot

Parameters” iletisim kutusu kapatilir. Cizim simdi Sekil 4.22°deki gibi

gorundur.
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Sekil 4.22 Polarizasyon egrisi



0,6 V polarizasyonundaki anot ve iyonik iletken arasindaki katman temas
noktasinda akim yogunlugu dagilimi grafigini olusturmak icin gerekli adimlar
asagida siralanmistir:

1.Menii 6gelerinden “Postprocessing>Domain Plot Parameters” secilir.

2.“General” sayfasinda “Solutions to wuse” listesinden  “0,6” segilir.
“Element refinement” i¢in “Auto” onay kutusu temizlenir ve
“associated” alanina “7” yazilir.

3.“Surface” sayfasinda sinir “9” secilir. (Anot ve iyonik iletken arasindaki ara
yiz ) ve “Predefined quantities” listesinden “Conductive Media DC
(electronic)>Normal current density” secilir.

4.“x- and y-axis” veri alanindan, asagi acilir listeden “Xy-plane” secilir.

5.“0OK?” e tiklanir.
0,1V, 0,6 V ve 0,8 V hiicre voltajlarindaki akim yogunlugu dagilimi Sekil
4.23, Sekil 4.24 ve Sekil 4.25°deki gibi olugsmustur. Hiicre voltaji arttik¢a
akim yogunlugunda bir artig goriilmekle birlikte, yogunluk dagilimi da
sekillerdeki gibi yer degistirmektedir.

0.1V htcre voltajinda akim yogunlugu [A/m:] Max: 1064.186
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Sekil 4.23 0,1 V Hiicre voltajinda akim yogunlugu
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0.6V Hucre voltajindak:i dam yogunlugu [A/rr?] Max: 6086.601
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Sekil 4.24 0,6 V Hiicre voltajinda akim yogunlugu
0.8 V hucre voltajnda alam yogunlugu [A/rrTﬂ] Max: 8037.675
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Sekil 4.25 0,8 V Hiicre voltajinda akim yogunlugu



Maksimum ¢ikis giicii - hiicre voltaji grafigi su sekilde olusturulur:

1.Menti 6gelerinden “Postprocessing>Domain Plot Parameters” secilir.

2.“General” sayfasinda “Solutions to use” listesinden biitiin ¢oziimler segilir.

3.“Point” sayfasinda, “Expression” alanina “P_out” yazilir.

4. Herhangi bir nokta segilir. Ornegin; 1. Nokta segilir.

5.“x-axis” veri alaninda, “Expression” alanina “V_cell” yazilir.

6.“OK” e tiklanir ve grafik olusturulur.
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Sekil 4.26 Cikis giicii - hiicre voltaji

Bu grafik ile maksimum gii¢ ¢ikisinin 0,65V hiicre voltajinda oldugu goriildii.

Son olarak, maksimum ¢ikis giicii- akim yogunlugu su sekilde olusturulur:

1. Menii 6gelerinden “Postprocessing>Domain Plot Parameters” secilir.

2.“General” sayfasinda “Solutions to use” listesinden biitiin ¢oziimler segilir.

3.“Point” sayfasinda, “Expression” alanina “P_out” yazilir.



4.Herhangi bir nokta segilir. Ornegin; 1. Nokta secilir.

5.“x-axis” veri alaninda, “Expression” alanina *j_ec” yazilir.

6.“OK” e tiklanir ve grafik olusturulur.
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Sekil 4.27 Cikis giicli — akim yogunlugu



4.8 Hidrojen gazi ile yapilan KOYP modeli

KOYP modelinin anot akigkani olarak hidrojen ve katot akigkani olarak hava
kullanildiginda olusan sonuglar bu kisimda agiklanacaktir.

Anot ve katot akiskanlar: kiitle oranlar1 dagilimlar1 asagidaki grafiklerdeki
gibi olugmustur.

V_pai(6)=0.5 Sice: Mas fraction, wil Max: 0.150

Min: 1038e-3

Sekil 4.28 Katottaki O, (w1) dagilimi



Max: 0.432

Min: 0370

V_pal(6)=0.5 Sice: Mass facton, w2

Yo

Sekil 4.29 Katottaki H,O (w2) dagilimi

V_pa6)=0.5 Sice: Mass Facton, w3

¥

Sekil 4.30 Katottaki N, (W3) dagilimi



0.3
0.25

a3

Y

Sekil 4.31 Anottaki H, (w4) dagilimi

Max: 0.849

0.6
Min: 0.600

V_pai(6)=0.5 Sice: Mass facton, w5

¥

Sekil 4.32 Anottaki H,O (W5) dagilimi



Huicre Voltaji- Akim Egrisi
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Sekil 4.33 Polarizasyon egrisi

0.5 V Huicre voltajinda akim yogunlugu [A/rr‘?] Max: 7242.496
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Sekil 4.34 0,5 V Hiicre voltajinda akim yogunlugu

Oksijen tiiketiminin sonucu olarak, akim yogunlugu dagilimi zayiftir ve
iretilen akimin c¢ogu katot girisine yakindir. Buna ek olarak, akim

yogunlugunun koselerde hafifce artmasiyla akim toplayicisinin pozisyonu



belirlenir. isletme sartlarmi gelistirmenin bir yolu da katot akis debisini

arttirmaktir bdylece oksijen kiitle transferi de artmis olur.
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Sekil 4.35 Cikis giicii - hiicre voltaji1 grafigi
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Sekil 4.36 Cikis giicli — akim yogunlugu grafigi



Bu kisimda H; — O, yakitli KOYP birim hiicresi dogalgaz yakitl birim

hiicre modeline bir karsilastirma olarak sunulmustur.
Burada 0,6 V hiicre voltajinda maksimum giice ulagildi. Maksimum gii¢

olarak 1050 W/m? degeri goriildii.
0,6 V hiicre voltajinda akim yogunlugu olarak 1500 A/m® degerine

ulasildi.

4.9 KOYP Modelinin deneysel calismalar ile karsilastirilmasi

Diizlemsel tipli kati oksitli yakit pili modelimiz, 2002 yilinda Shanghai
Seramik Enstitiisii ve Cin Bilim Akademisinde yapilan bir arastirma ile

karsilastirilmistir (Wen et al.,2002). Deneysel calismada 40 x 40 mm boyutundaki

diizlemsel hiicre malzemeleri ve 6zellikleri ise soyledir:

Cizelge 4.16 40 x 40 mm boyutundaki diizlemsel hiicre malzemeleri ve 6zellikleri

Bilesen Malzeme Kalinlik
Elektrolit Itriyum dengeli zirkonya(YSZ) 0,2 mm
Anot Ni +YSZ Madeni seramik 40 um
Katot Pro7SrosMnQO3 90 pm
Ara Baglanti Ni kapl alagimli ¢elik 100 x 100mm




Ayrica yalittim malzemesi olarak SiO,—Al,03—CaO kullanilmustir.

1999 baglarinda malzeme arastirmasina ve bilesen imalatina dayandirilarak
10 hiicreli KOYP dizini yapilmis ve ¢alistirnlmistir. Deneyde elektrolit destekli
hiicre yapisi se¢ilmistir. Dizin, 0,2 mm kalinliginda elektrolit igeren 10 hiicreden
meydana gelmis olup 40x40 mm alana sahiptir. Kullanilan gazlarin oranlari ise
%10 Hy/Hava, %10 H,/O, ve H,/O,‘dir. Bu oranlar igin agik devre voltajlari(OCV)
ise, sirastyla 8,6, 9,5 ve 10,7 V tur.

10 hiicreli demetin, 900-1000 °C sicaklikta birkag giin ¢alistirildiktan sonraki
halinin fotografi Sekil 4.28’te gosterilmistir.

Sekil 4.37 10 dizinli yakat pili hiicresinin dig goriiniisii (Wen et al., 2002)

Bu yakit pili dizini 850 ve 1350 A/m? yiikleri altinda ve bosta ¢alistiginda

dizin voltaji- zaman grafigi Sekil 4.38”de gosterilmistir.



12 i 1000°C' de 10 Hiicreli KOYP Dizini )
Ab-Abep b .. A
104 i}
=
ri—_" L gy 1
w
= ¢ 00000000
s . i
E - 850 A/m? viik altnda
a 4 Qe 1350 A/m? viik altinda i
R 1 weens Actk Devre 1
0 T T T T T T T
0 2 4 6 8 10 12 14

Faman (saat)
Sekil 4.38 Dizin voltaji — Zaman grafigi (Wen et al., 2002)
Burada 10 hiicreli dizinin 1000 °C’deki giic yogunlugu-akim grafigi

Sekil 4.39°da gosterilmistir. Hiicre birim alani ise 40 x 40 mm? (0,0016 m?)
dir.
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Sekil 4.39 10 hiicreli dizin voltaji — akim- gii¢ yogunlugu grafigi (Wen et al., 2002)



Burada ise 80 hiicreli dizinin 1000 °C’deki gii¢ yogunlugu-akim grafigi
Sekil 4.40’ta gdsterilmistir. Hiicre birim alam ise 100 x 100 mm? (0,01 m?)

dir.
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Sekil 4.40 80 hiicreli dizin voltaji — akim- gii¢ yogunlugu grafigi (Wen et al., 2002)

Bu ¢alismada 1000 °C’de 80 adet dizine kadar deneyler yapilmistir. Anot
tarafinda yakit olarak hidrojen, katot tarafinda oksitleyici olarak oksijen ile yapilan
deneylerde maksimum ¢ikis giicii olarak 810 W goriilmiistiir (Wen et al., 2002).

KOYP Modelimizdeki degerlerde asagidaki gibi olusmustur ve yukaridaki

deneysel sonuclarla karsilastirildiginda uyumlu sonuglar géstermektedir:
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Sekil 4.41 KOYP Modeli ¢ikis giicii- hiicre voltaj1 grafigi
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Sekil 4.42 KOYP Modeli ¢ikis giicii- akim yogunlugu grafigi
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Sekil 4.43 KOYP Modeli hiicre voltaj1 - akim egrisi grafigi

Ayrica modelimizden daha yiiksek sicakliklarda yapilan deneysel ¢aligmalar

ve sonuglart asagidaki grafikte gosterilmistir (Janardhanan and Deutschmann,
2006).
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Sekil 4.44 Farkli sicakliklardaki hiicre voltaji — akim — gii¢ yogunlugu grafigi

Buradaki calismada yakat bilesimi %97 CHy4 - %3 H,0 olarak degisik sicaklik
araliginda tasarim yapilmistir. Deneysel ¢alisma sonuglar ile tasarim hesaplamalari
yakin sonuglar gostermistir (Janardhanan and Deutschmann, 2006). Sicakliklar

azaldikca akim yogunlugunda modelimizdeki gibi diisiis gozlenmistir.



5. SONUC VE TARTISMALAR

Cagimizda modern toplumlarin ilk ihtiyact her zaman enerji olmustur. Fakat
enerji siirekli ve temiz oldugu zaman bir anlam kazanmaktadir. Bu manada
konvansiyonel enerji liretimine karsi, kat1 oksitli yakit pillerinin 6nemli avantajlar
oldugu agiktir.

Bu ¢alismada yakit doniistiiriiciide doniistiiriilmiis dogalgaz yakith kat1 oksitli
yakit pili dizini modellenmistir. Birim hiicre temel alinarak analizler yapilmstir.
Model ise sonlu elemanlar yontemiyle COMSOL 3.5a ticari yazilimi yardimiyla

gerceklestirilmistir.

Diinyadaki uygulamalarindan referans alinarak birim hiicre geometrisi
tasarlanmistir. Anot tarafi akigkani olarak doniistiiriilmiis dogalgaz, katot tarafi
akiskani olarak hava diisiiniilmiistiir. Anot ve katot tarafi gazlarinin giris ve ¢ikis

kiitlesel oranlar1 incelenmis, ayrintili grafiklerle (Sekil 4.14 - 4.20) sunulmustur.

Akim yogunlugu dagilimi, 0,1 V, 0,6 V ve 0,8 V hiicre voltajlarindaki Sekil
4.23, Sekil 4.24 ve Sekil 4.25°deki gibi olusmustur. Hiicre voltaj1 arttikga akim
yogunlugunda bir artis goriilmekle birlikte, yogunluk dagilimi da sekillerdeki gibi
yer degistirmektedir.

Polarizasyon egrisi incelendiginde, akim yogunlugu arttik¢a hiicre voltajinda
bir diisiis oldugu gozlendi. Olusan egri, Sekil 4.39, Sekil 4.40 ve Sekil 4.44’teki
deneysel ¢aligmalar ile uygunluk gostermektedir (Wen et al.,2002; Janardhanan and
Deutschmann, 2006; Yamamoto O.,1999; Wang et al.,2009).

Maksimum gii¢ ¢ikisinin oldugu 0,65 V hiicre voltajinda, 650 A/m? akim
yogunluguna ulasild1 ve gii¢ ¢ikisi olarak 500 W degeri goriildii. Sekil 4.39 ve Sekil
4.40’teki verilerle karsilastirildiginda yakin sonuglar elde edildigi goriilmektedir.



Yakit donistiiriiciide doniistiiriilmiis dogalgaz yakitlh KOYP modelimizin
performansini karsilagtirmak i¢in daha onceden literatiire girmis bir calisma ele
alimmistir. Bu deneysel ¢alismada, bizim c¢alismamiza benzer olarak 1000 ° C
sicaklikta, anot tarafi akiskani hidrojen ve katot tarafi akiskani oksijen olarak 10 ile
80 hiicreli bir dizin meydana getirilmistir. Sonuglar karsilagtirildiginda hiicre
voltaji-akim  yogunlugu ve hiicre voltaji- giic c¢ikist sonuglart uygunluk
gostermektedir. 80 hiicreli dizin ¢alismasinda deneysel olarak birim hiicre basina
810 W maksimum ¢ikis gilicline ulagilmistir. Modelimizde ise 500 W ¢ikis giicii
elde edilmistir. Bu farklilik, model boyutlari, yakit pili akiskanlari, gozeneklilik,

yalitim gibi faktorler sonucunda olugmustur.

Sekil 4.44’te grafik ile gosterilen calismada yakit bilesimi %97 CH4 - %3
H,O olarak degisik sicaklik araliginda tasarim yapilmistir. Deneysel calisma
sonuglari ile tasarim hesaplamalar1 yakin sonuglar gostermistir (Janardhanan and
Deutschmann, 2006). Sicakliklar azaldik¢a akim yogunlugunda modelimizdeki gibi
diisiis gbzlenmistir.

Ayrica KOYP modelimiz, karsilastirma yapmak amaciyla, hidrojen yakiti ile
diger parametreler ayn1 kalacak bicimde yeniden tasarlanmistir. Model sonuglari,
Sekil 4.28- 4.36 grafikleri ile ayrintili bir bigimde gosterilmistir. Bu modelde 0,6 V
hiicre voltajinda maksimum giice ulasildi. Maksimum gii¢ olarak 1050 W/m? ve

akim yogunlugu olarak 1500 A/m? degerine ulagildi.

Sonug olarak, dogalgaz yakithh KOYP’lerinin verimini tasarim geometrisi,
boyutlar1, sicaklik, anot-katot- elektrolit malzeme yapisi, yalitim gibi faktorler
degistirmektedir. Malzeme bilimi ve nano-teknoloji gelistikce, KOYP’leri

hayatimizda daha ¢ok yer alacaklardir.
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// Thermodynamics package in java

/I GasPropertySWF class to calculate properties of gases
/I user interface (JFrame)

// Dr. Turhan Coban

// TUBITAK Ulusal Metroloji Enstitiisii

// email : Turhan.Coban@ume.tubitak.gov.tr

import java.io.*;

import java.applet. Applet;
import java.awt.*;

import java.awt.event.*;
import java.util.*;

import javax.swing.*;

Import javax.swing.table.*;

public class GasTable extends JApplet

ActionListener,ltemListener,Serializable

{

implements

private static final long serialVVersionU1D=3580448895730030990L;

String s1[]={"SI","EN"};

String s2[]={"mole","mass"};

String unit;

String base;

JPanel inputPanel;

JPanel outputPanel;

JPanel totalPanel;

JLabel I11[]=new JLabel[5]; // Label

JLabel I2[]=new JLabel[5]; /l Label
JTextField t1[]=new JTextField[3]; // input fields
JComboBox c1[]=new JComboBox[3]; // selection field
JTextArea outputTextArea,;

GasModel gm;



public Gas g1;

JTable jt;

double T;

double P;

public String gasName;

protected File gmixFile;
protected StringTokenizer token;
String st[];

Color bg;

Color fg;

public void init()

{
Container c=getContentPane();
c.setLayout(new FlowLayout());
bg=c.getBackground();
fg=c.getForeground();
/ladding max-min prompts and input fields
gasName=new String("air");
unit="SI";
base="mole";
T=25.0;
P=1.0;
inputPanel=new JPanel();
inputPanel.setLayout(new GridLayout(5,3,80,1));
outputPanel=new JPanel();
outputPanel.setLayout(new BorderLayout());
totalPanel=new JPanel();
totalPanel.setLayout(new BorderLayout());
c1[0]=new JComboBox(s1);
c1[1]=new JComboBox(s2);

try{



gl=new Gas(gasName);

System.out.printin("gf="+g1.gf);

token=new StringTokenizer(gl.readGasNames());

st=new String[token.countTokens()];

} catch(IOException ioe) {System.out.printIn("lOException™);}
int i=0;
while(token.hasMoreTokens())

{
st[i++]=new String((String)token.nextToken());

by
c1[2]=new JComboBox(st);
t1[0] = new JTextField();
t1[1] = new JTextField();
t1[2] = new JTextField();
t1[2].setText(gasName);
gasName=(String)c1[2].getSelectedltem();
try{

gl=new Gas(gasName);

} catch(IOException ioe) {System.out.printIn("lOException™);}

I1[0]=new JLabel("unit system ");
fg=I1[0].getForeground();

I1[1]=new JLabel("mass/mole ");
I1[2]=new JLabel("gas Name ");
I1[3]=new JLabel("temperature ");
I1[4]=new JLabel("pressure ");

12[0]=new JLabel(" ");

12[1]=new JLabel(" ");

12[2]=new JLabel(" ");

12[3]=new JLabel(" degree C ");
12[4]=new JLabel(" bars ");
outputTextArea=new JTextArea();
Font fn=I1[0].getFont();

for(i=0;i<5;i++)



{ I1[i].setBackground(Color.lightGray);
12[i].setBackground(Color.lightGray);

¥

t1[0]=new JTextField(""+T);

t1[1]=new JTextField(""+P);

for(i=0;i<3;i++)

{ t1[i].setBackground(bg);t1[i].setFont(fn); }

for(i=0;i<3;i++)

{ cl[i].setBackground(bg);t1[i].setFont(fn); }

outputTextArea.setBackground(bg);

outputTextArea.setForeground(fg);

outputTextArea.setFont(fn);

inputPanel.add(11[0]);
inputPanel.add(c1[0]);
inputPanel.add(12[0]);

inputPanel.add(I1[1]);
inputPanel.add(c1[1]);
inputPanel.add(I12[1]);

inputPanel.add(11[2]);
inputPanel.add(c1[2]);
inputPanel.add(t1[2]);

inputPanel.add(11[3]);
inputPanel.add(t1[0]);
inputPanel.add(12[3]);

inputPanel.add(11[4]);
inputPanel.add(t1[1]);
inputPanel.add(12[4]);



c1[0].addItemListener(this);
cl[1].addItemListener(this);
c1[2].addItemListener(this);

t1[0].addActionListener(this);
t1[1].addActionListener(this);
t1[2].addActionListener(this);

double TK=T+273.0;

gm=new GasModel(g1,TK,P);

jt=new JTable(gm);

jt.setBackground(bg);

jt.setFont(fn);

setArea();
outputPanel.add(outputTextArea,BorderLayout. NORTH);
outputPanel.add(jt,BorderLayout. SOUTH);
totalPanel.add(inputPanel,BorderLayout. NORTH);
totalPanel.add(outputPanel,BorderLayout. SOUTH);
c.add(totalPanel,BorderLayout. NORTH);

public void setArea()
{
t1[0].setText(Double.toString(T));
t1[1].setText(Double.toString(P));
String s=""";
s+="Dr. Turhan Coban, \n";
s+="Ege Universitesi, Miihendislik Bilimleri Fak., Makina Boliimii\n";
s+="phone : 90(232)3434000-5387\n";
s+="email : turhan.coban@mail.ege.edu.tr\n";
s+="web : www.axtelsoft.com/turhan.coban\n"; /Inote if you would like to
list additional information on the screen

//add to string s



s+="Gas Formula : "+g1.toString()+"\n";
gm.setValues(g1,unit,base, T,P);
outputTextArea.setText(s);

}

public void itemStateChanged(ltemEvent ev)
{

gasName=(String)c1[2].getSelectedltem();
t1[2].setText(gasName);
unit=(String)c1[0].getSelectedltem();

if(unit=="EN") {12[3].setText(" degree F ");
12[4].setText(" psia (Ibf/in”2)  ");}

else {12[3].setText(" degree C ")
12[4].setText(" bars ")}

base=(String)c1[1].getSelectedltem();

try{

gl=new Gas(gasName);

gl.base(base);

gl.unit(unit);

t1[0].setText(" ");

t1[1].setText(" ");

} catch(IOException ioel) {System.out.printin("IOException”);}
/lg1.property(T,P);

setArea();

repaint();

}

public void actionPerformed( ActionEvent e)

{
if(e.getSource()==t1[2])

{
String st1=(String)c1[2].getSelectedItem();



gasName=st1,
String st2=t1[2].getText();
for(int j=0;j<st.length;j++)
{
if(st[j].equals(st2))
{
gasName=st2;
c1[2].setSelectedltem(st2);
try{
gl=new Gas(gasName);
gl.base(base);
gl.unit(unit);
} catch(IOException ioel) {System.out.printin("IOException™);}
break;

¥
¥

}
Double valTemp=new Double(t1[0].getText());

T=valTemp.doubleValue();

Double valPressure=new Double(t1[1].getText());
P=valPressure.doubleValue();

getContentPane().setLayout(new FlowLayout(FlowLayout.RIGHT));
setArea();

repaint();

public static void main(String s[]) {
JFrame f = new JFrame("Properties of Perfect Gases ");
f.addWindowListener(new WindowAdapter() {

public void windowClosing(WindowEvent e) {System.exit(0);}
b
JApplet applet = new GasTable();
f.getContentPane().add("Center", applet);
applet.init();



f.pack();
f.setSize(new Dimension(500,600));
f.setVisible(true);

EK 2 Gkarisim.java



// File Name : Gmix.java

/I Author

: Dr. Turhan Coban

I TUBITAK Ulusal Metroloji Enstitiis

/I email

: Turhan.Coban@ume.tubitak.gov.tr

// Description : This file contains class gmix which calculates

/Il thermophysical properties of mixture of perfect gases.

I
I
I
I
I
I
I
I
I
I
I
I
I
I
I
I

following properties can be calculated

T() : Temperature degree K

h(T) :enthalpy KJ/kmol

hf  : formation enthalpy KJ/kg

ht(T) : total enthalpy KJ/kg (h+hf)

M : molar mass kg/kmol

HT(T) : total enthalpy KJ : M*ht(T)

P() : presure bar

s(T,P) : entropy KJ/kmol K

Cp(T) : specific heat at constant pressure KJ/kmol K
Cv(T) : specific heat at constant volume KJ/kg K
gamma(T): adiabatic constant Cp/Cv

c(T) :speed of sound m/s

u(T) : Internal energy KJ/kmol

vis(T) : viscosity

k(T) :thermal conductivity KW/kg K

/ DATA FILE DEFINATION

/I gas mixture definations are given the data file "Gmix.txt"

/I if gas mixture data is not given in the Gmix.txt user can be add

/l his own data to the file which has the following format

// gmixName

/Il ngas

/l gname_ ON_O



// and defination : gmix a(gmixName); will defined this gas mixture

I/ the same mixture can be defined directly in the main program as :

/Il Gas a_ngas=new Gas("a_ngas);
/I Gmix a=new Gmix;

/l a=N_0*a_0+...+N_ngas*a_ngas;

/I VARIABLE IDENTIFICATION

/I all the variables that type is not defined is a double variable

// PUBLIC VARIABLES :

/I gasName : String class variable of gas mixture name

/I ngas :int variable, number of simple gasses

/' N : total molar mass of the gas mixture

I/ gasL.ist :gas class vector variables

/I All the other variables defined for class gas is also valid for gmix
import java.io.*;

import java.util.*;

class Gmix{
/I this class calculates perfect gas thermodynamic
/I properties when the perfect gas constitutes of
/I several single gases

boolean mole=false;



boolean Si=true;

public int ngas; // number of simple gasses inside of the gas mixture
String gasName;

public double M; // molar mass of atom kg/kmol

public double h0; // enthalpy at T=298 K

public double hf; // enthalpy of formation

public double sf; // entropy of formation  kJ/kmol K
public double N; // moles of gas kmol

int ierror;

int natom; /Inumber of unique atoms in the atom list
Gas gasList[]; //list of the component gasses

Atom atomList[]; //list of component atoms

File gmixFile;  // File name and directory
BufferedReader cfin;

/I construction methods :

/lconstructor functions
public Gmix(String name) throws IOException
{
/I class complex gas construction function
/I this function reads the initial gases in
// the mixture and their molar weight from
/I the file Gmix.txt and construct mixed gas
try{
cfin=new BufferedReader(new FileReader("Gmix.txt"));
int ierror=1;
intij;
N=0;
M=0;
hf=0;
natom=0;
try{
while(cfin!=null)



{

gasName=Text.readString(cfin);
if(gasName.equals(name)) { ierror=0; break;}
} /lend of while
} catch(EOFException e_eof)
{
System.out.printIn("error required gas mixture "+name+" is not found");
cfin.close();return;
}
llcfin>>ngas;
ngas=Text.readInt(cfin);
gasList=new Gas[ngas];
Ilierror=0;
String pgasName;
double ppercent;
Gas tempgas;
for(i=0;i<ngas;i++)
{
pgasName=Text.readString(cfin);
ppercent=Text.readDouble(cfin);
/lcfin>>pgasName>>ppercent;
tempgas=new Gas(pgasName,ppercent);
ierror=tempgas.ierror;
{
if(ierrorl=1)
{
try{

gasList[i]=new Gas(tempgas);

} catch(IOException ioe) {System.out.printin("lOException™);}
N-+=tempgas.N;
M+=tempgas.N*tempgas.M;

hf+=tempgas.N*tempgas.hf;

¥



else

System.out.printIn("gas is not found in the list");
System.out.printIin("this gas is not added to the list™);
i--;
ngas--;
¥
}
}
M=M/N;
hf=hf/N;

arrange_atoms();

} catch(FileNotFoundException fnfe) {System.out.printIn("File not found™);}

public String readGmixNames() throws IOException
{

String temp=new String("");

String pgasName;

double ppercent;

try{
cfin=new BufferedReader(new FileReader("Gmix.txt"));
try {
while(cfinl=null)
{

temp=temp+Text.readString(cfin)+ " ";
ngas=Text.readInt(cfin);

for(int i=0;i<ngas;i++)

{

pgasName=Text.readString(cfin);



ppercent=Text.readDouble(cfin);
} //end of while

}
} catch(EOFException e_eof) {cfin.close();}

}
catch(FileNotFoundException fnfe) {System.out.printin("File Gmix.txt not

found");}

return temp;

public void arrange_atoms() throws IOException
{
inti};
for(i=0;i<ngas;i++)
{
for(j=0;j<gasList[i].natom;j++)
{
add_atom(i,j);
}

public int add_atom(int i,int j) throws IOException

{

int k;

/[Atom tempAtom=new
Atom(gasList[i].atomList[j].symbol,gasList[i].atomList[j].N*gasList[i].N/N);
for(k=0;k<natom;k++)

{



//String sO=gasL.ist[i].gasName;
String s1=gasList[i].atomList[j].symbol;
String s2=atomL.ist[k].symbol,
//System.out.printIn(*natom ="+natom+"k =
"+k+atomList[k].symbol+"s0="+s0+"s1="+s1+"s2="+52);
if(sl.equals(s2))
{
atomList[k]=new
Atom(atomList[k].symbol,atomList[K].N+gasList[i].atomList[j].N*gasList[i].N/N);
return 1;
by

}
Atom atomL[];

atomL=new Atom[natom+1];

for(k=0;k<natom;k++)

atomL[k]=new Atom(atomList[k]);

atomL[natom]=new
Atom(gasList[i].atomList[j].symbol,gasList[i].atomList[j].N*gasList[i].N/N);
atomList=atomL;

natom+=1;

return 2;

public Gmix() throws IOException
{

/lempty construction function
N=0;

M=0;

String pgasname="\0";

ngas=0;

¥



public Gmix(Gmix g1) throws IOException

{

gasName=g1.gasName;

gasName=gasName;

N=g1.N;

M=g1.M;

hf=g1.hf;

ngas=gl.ngas;

natom=gl.natom;

gasList=new Gas[ngas];

for(int i=0;i<ngas;i++) gasList[i]=new Gas(gl.gasList[i]);
for(int i=0;i<natom;i++) atomList[i]=new Atom(gl.atomList[i]);

public Gmix(Gas g1) throws IOException
{
gasName=gl.gasName;
gasName=gasName;
N=g1.N;
M=gl1.M;
hf=g1.hf;
ngas=1,
natom=gl.natom;
gasList=new Gas[ngas];
for(int i=0;i<ngas;i++) gasList[i]=new Gas(gl);
for(int i=0;i<natom;i++) atomList[i]=new Atom(gl.atomList[i]);

}



public void changeN(double newN) throws I0Exception

{

normalise();
for(int i=0;i<ngas;i++)

{ gasList[i].N*=newN; }
N=newN;,

}

public boolean base(String s)

{

if(s.equals("mole™)) {mole=true;for(int i=0;i<ngas;i++){ gasList[i].mole=true; }}
else {mole=false;for(int i=0;i<ngas;i++){ gasList[i].mole=false;}}
return mole;

}

public boolean unit(String s)

{
if(s.equals("SI")) {SI=true;for(int i=0;i<ngas;i++){ gasList[i].SI=true; }}
else {SI=false;for(int i=0;i<ngas;i++){ gasList[i].SI=false; }}
return Sl,
}

I

public void add(Gas g1) throws IOException
{
/[ this function adds a single gas to the mixture
int gasflag=1;
/I if the gas exist in the list simply change N and M values

for(int i=0;i<ngas;i++)



{

if(gasList[i].gasName.equals(gl.gasName))

{
gasflag=0;
M=M*N+g1.M*g1.N;
gasList[i].N+=g1.N;
N+=g1.N;
M=M/N;
}
¥
if(gasflag!=0)
{
Gas newGas[];
newGas=new Gas[ngas+1];
for(int i=0;i<ngas;i++)
{
newGas[i]=new Gas(gasList[i]);
}
ngas++;
double MT=M*N+g1.M*g1.N;
N+=gl1.N;
M=MT/N;
newGas[ngas-1]=new Gas(gl);
gasList=newGas;

}

arrange_atoms();

public void remove(String name) throws IOException

{

// this function removes a single gas
I/ from the list
intik;



for(i=0;i<ngas;i++)
{
if(gasList[i].gasName.equals(name))
{
Gas newGas[];
newGas=new Gas[ngas];

M=0;
N=0;

for(k=0;k<i;k++)

{ newGas[k]=new Gas(gasList[Kk]);
M+=newGas[k].M*newGas[k].N;
N+=newGas[k].N;

}

for( k=i;k<(ngas-1);k++)

{
newGas[k]=new Gas(gasL.ist[k+1]);
M+=newGas[k].M*newGas[k].N;

N+=newGas[K].N;

}

M=MI/N;

ngas--;
gasList=newGas;
break;

¥
¥

arrange_atoms();

/I correct dynamic memory size

|| ================ == == == ===

public void add(String name,double Nnew) throws IOException

{

/I this function adds a single gas to the mixture

Gas gl=new Gas(name,Nnew);



int gasflag=1;

/I if the gas exist in the list simply change N and M values

for(int i=0;i<ngas;i++)

{

if(gasList[i].gasName.equals(gl.gasName))

{
gasflag=0;
M=M*N+g1.M*g1.N;
gasList[i].N+=g1.N;
N+=g1.N;
M=MI/N;
}
}
if(gasflag!=0)
{
Gas newGas[];
newGas=new Gas[ngas+1];
for(int i=0;i<ngas;i++)
{
newGas[i]=new Gas(gasList[i]);
}
ngas++;
double MT=M*N+g1.M*g1.N;
N+=g1.N;
M=MT/N;
newGas[ngas-1]=new Gas(gl);
gasList=newGas;

}

arrange_atoms();

public void simplify() throws IOException



{

// this function combines any single gas

/I that repeated in the list

double ngasold=ngas;

inti}j,k;
for(i=0;i<ngas;i++)
{
for(j=i+1;j<ngas;j++)
{

if(gasList[i].gasName.equals(gasList[j].gasName))

{
gasList[i].N+=gasList[j].N;
for(k=j;k<(ngas-1);k++)

{ gasList[k]=new Gas(gasList[k+1]); }

ngas--;
}

¥
¥

/I correct dynamic memory size
if(ngasold!=ngas)
{

Gas newGas[];

newGas=new Gas[ngas];
for(i=0;i<ngas;i++)

{
newGas[i]=new Gas(gasList[i]);

}

gasList=newGas;




public void normalise() throws IOException

{

for(int i=0;i<ngas;i++)
{
gasList[i].N=gasL.ist[i].N/N;
¥

N=1.0;

arrange_atoms();

public void changeMix(double Nmix[]) throws IOException

{

/[ this function changes

/1 all the molar weights in the mixture
N=0;
M=0;

for(int i=0;i<ngas;i++)
{
gasList[i].N=Nmix][i];
N+=Nmix[i];
M+=Nmix[i]*gasList[i].M;
}
M=MI/N;

arrange_atoms();

public double vis(double T)
{

/I dynamic viscosity of the mixture

/I note that viscosity of the mixture IS NOT the simple addition

/I of viscosity of component gasses
double vmix=0;

for(int i=0;i<ngas;i++)



{

T=T;

double fij;

double xj=0;

double p1;

double c1,c2,c3;

for(int j=0;j<ngas;j++)
{
double vratio;
double xi=gasList[i].M/gasList[j].M;
if(gasList[j].vis(T)!=0)

{
cl=gasList[i].vis(T)/gasList[j].vis(T);
vratio=Math.sqrt(cl);

}
else
vratio=0;
c2=Math.pow(xi,0.25);
pl=(1+vratio/c2);
€3=8.0+8.0*xi;
fij=p1*pl / Math.sqrt(c3);
xj+=fij*gasList[j].N/N;
}
vmix+=gasList[i].N/N*gasList[i].vis(T)/xj;
}

return vmix;

public double k(double T)

{

// thermal conductivity of the mixture

/I note that thermal conductivity of the mixture IS NOT the

I/l simple addition of the thermal conductivity of component gasses



I

I

double vmix=0;
for(int i=0;i<ngas;i++)
{
T=T,
double fij;
double xj=0;
double p1;
double c1,c2,c3;
for(int j=0;j<ngas;j++)
{
double vratio;
double xi=gasList[i].M/gasL.ist[j].M;
if(gasList[j].k(T)!=0)
{
cl=gasList[i].k(T)/gasList[j].k(T);
if(c1<0) System.out.printIn("negative c1 value ");
vratio=Math.sqrt(c1);
}
else
vratio=0;
c2=Math.pow(xi,0.25);
pl=(1+vratio/c2);
c3=8.0+8.0*xi;
if(c2<0) System.out.printIn(*" negative c2 value ");
fij=p1*pl/Math.sqrt(c3);
xj+=fij*gasList[j].N/N;
}
vmix+=gasList[i].N/N*gasList[i].k(T)/xj;
}

return vmix;

¥



public double Prandtl(double t)
{

/I Prandtl number
return Cp(t)*vis(t)/k(t)/M*1e3;

public double h(double T)
{
/Ispecific enthalpy of the mixture KJ/kmol
double HH=0;
for(int i=0;i<ngas;i++)
{ HH+=gasList[i].h(T)*gasList[i].N; }
return HH/N;

public double ht(double T)
{
/Ispecific enthalpy of the mixture ht=h+hf
I/ hf : formation enthalpy
double HH=0;
for(int i=0;i<ngas;i++)
{ HH+=gasList[i].ht(T)*gasList[i].N; }
return HH/N;
}



I

public double H(double t)

{
/total enthalpy of the mixture KJ

return h(t)*N;

public double HT(double t)
/total enthalpy of the mixture HT=N*(h+hf)

{
return ht(t)*N;

KJ

public double u(double T)
{

/1 specific internal energy of the mixture KJ/kmol

double UU=0;
for(int i=0;i<ngas;i++)
{ UU+=gasList[i].u(T)*gasList[i].N; }
return UU/N;
}

public double g(double T,double P)

{

}

return h(T)-T*s(T,P);



public double gt(double T,double P)
{

return h(T)+hf-T*s(T,P);
¥

public double gt(double T)
{
double Pref;
if(1S1) {Pref=14.503684;}
else {Pref=1.0;}
return h(T)+hf-T*s(T,Pref);

public double g(double T)

{
double Pref;

if(1SI) {Pref=14.503684;}

else {Pref=1.0;}

return h(T)-T*s(T,Pref);
}

public double G(double T,double P)

{
return g(T,P)*N;

}

public double G(double T)

{
return g(T)*N;

}

public double GT(double T)



{
return gt(T)*N;

}

public double GT(double T,double P)

{
return gt(T,P)*N;

public double Cp(double T)
{

/I Specific energy at constant pressure KJ/kmol K

double C=0;

for(int i=0;i<ngas;i++)

{ C+=gasList[i].Cp(T)*gasList[i].N; }

return C/N;

// - ==

public double Cv(double T)

//Specific energy at constant volume KJ/kmol K

{
double C=0;

for(int i=0;i<ngas;i++)

{ C+=gasList[i].Cv(T)*gasList[i].N; }

return C/N;

public double gamma(double T)
{

/ladiabatic constant
return Cp(T)/Cv(T);



public double c(double T)

/Ispeed of sound m/s

{
return Math.sqrt(8314.5/M*T*gamma(T));

public double s(double T, double P)

{

IIspecific entropy KJ/kmol K

double SS=0;

for(int i=0;i<ngas;i++)
{
SS+=gasList[i].s(T,P)*gasList[i].N;
}

return SS/N;

}

public double s(double T)

{

IIspecific entropy KJ/kmol K

double P=1.0;

double SS=0;

for(int i=0;i<ngas;i++)
{
SS+=gasList[i].s(T,P)*gasList[i].N;
}

return SS/N;

}
public double pr(double T)

{
double Tref, Rref;



if(!SI) {Tref=491.67;Rref=1.986;}

else {Tref=273.15;Rref=8.3145;}

if(mole) Rref/=M;

return Math.exp((s(T)-s(Tref))/Rref);
}

public double vr(double T)
{
double Rref;
if(1SI) {Rref=1.986;}
else {Rref=8.3145;}
return (Rref/M)*T/pr(T)*10;

public double v(double T, double P)

{
double VV=0;

for(int i=0;i<ngas;i++)

{ VV+=gasList[i].v(T,P)*gasList[i].N; }

return VV/N;

public double T( char name,double y0,double p)

{
double t=300;

if(name=="v") {t= p*1e5*y0/8.314e3;}
else

{

double dt;

int nmax=400;

double tolerance=1.0e-8;

for(int i=0;i<nmax;i++)



{
if (name=='n") dt=-(h(t) -y0) /Cp(t);
else if(name=="u") dt=-(u(t) -y0) /Cv(t);
else if(name=="s") dt=-('s(t,p) - yO ) /(Cp(t)/t);
else { System.out.printin(*wrong name defined please try h,u,s ot v");
break;}
t+=dt;
if(Math.abs(dt)<tolerance) break;
}
¥

return t;

// T TTTT—CT == == == - == == ===

public double P( char name,double y0,double t1)

{

if(name=='v")  return 8.314e3*t1/y0*1e-5;

else if (hame=="s") return Math.exp((s(t1,1.0)-y0)/8.314);

else { System.out.printin("wrong name defined please try s or v*'); return 1.0;}

¥
/| ================ S================= =============
public void multiplyassign(double Nx)
{

for(int i=0;i<ngas;i++)

{ gasList[i].N*=NXx; }

N*=NX;
}
/| ================ S================= =============
public void addassign(Gas g1) throws IOException
{

/[ this function adds a single gas to the mixture
int gasflag=1;
/I if the gas exist in the list simply change N and M values

for(int i=0;i<ngas;i++)



{

if(gasList[i].gasName==g1.gasName)

{
gasflag=0;
M=M*N+g1.M*g1.N;
gasList[i].N+=g1.N;
N+=g1.N;
M=M/N;
}
¥
if(gasflag!=0)
{
Gas newGas[];
newGas=new Gas[ngas+1];
for(int i=0;i<ngas;i++)
{
newGas[i]=new Gas(gasList[i]);
}
ngas++;
double MT=M*N+g1.M*g1.N;
N+=gl1.N;
M=MT/N;
newGas[ngas-1]=new Gas(gl);
gasList=newGas;

public void addassign(Gmix right) throws IOException

{

/[ this function adds a gas mixture to the mixture

for(int i=0;i<right.ngas;i++)

{

add(right.gasList[i]);



public Gmix multiply( double Nx,Gmix right) throws IOException

{
Gmix gl=new Gmix(right);
g1.N*=NXx;
for(int i=0;i<gl.ngas;i++)
{
gl.gasList[i].N*=NXx;
by

return g1;

public Gmix add(Gas 1,Gas r) throws IOException
{

Gmix gl=new Gmix(r);

Gas g2=new Gas(l);

gl.add(g2);

return gi;

public Gmix add(Gmix I,Gas r) throws IOException
{

Gmix gl=new Gmix(l);

Gas g2=new Gas(r);

gl.add(g2);

return gi;

public Gmix add(Gas I,Gmix r) throws IOException
{

Gmix gl=new Gmix(r);



Gas g2=new Gas(l);
gl.add(g2);
return g1,

public Gmix add(Gmix I,Gmix r) throws IOException
{

Gmix gl=new Gmix(l);

for(int i=0;i<r.ngas;i++)

{
gl.add(r.gasList[i]);
}
return g1,
¥
/| ================ooooooosSooooooooooooooSoooSSSoSSooosoossos
public void assign(Gmix g1) throws IOException
{
gasName=gl.gasName;
N=g1.N;
M=g1.M:;
ngas=gl.ngas;
Gas newGas[];
newGas=new Gas[ngas];
for(int i=0;i<ngas;i++) newGas[i]=g1.gasList[i];
gasL.ist = newGas;
}
/| ===============ooooooooooooooooooooooooooooooooooooSosooos
public void assign(Gas g1) throws IOException
{

/l a single gas is assigned to the mixture
gasName=gl.gasName;
N=g1.N;
M=gl1.M;



ngas=1;

gasList=new Gas[ngas];

gasList[0]=new Gas(gl);
¥

public String toString(String ch)
{
/lreturn the ¢
String s=""";
intij;
if(ch.equals("name™))
s=s+gasName+"\n";
else if(ch.equals("formula™))
{
for(i=0;i<ngas;i++)
{ s=s+" "+gasL.ist[i].toString()+" "+gasList[i].N+"\n"; }
}
else if(ch.equals("composition™))
{
for(i=0;i<natom;i++)
s=s+atomList[i].toString()+"\n";
}

return s;

}

public String[][] toString1(double v1, double v2)
{

String s1[][]=new String[20][3];

s1[0][0]="P, pressure

s1[1][0]="T, temperature

s1[2][0]="v, specific volume "

s1[3][0]=" density "

s1[4][0]="h, enthalpy



s1[5][0]="u, internal energy "
s1[6][0]="s, entropy "
s1[7][0]="g, qibbs free energy "
s1[8][0]="ht,chemical entropy "
s1[9][0]="gt,chemical gibbs f.e.  *;
s1[10][0]="Cp, specific heat at const P ";
s1[11][0]="Cyv, specific heat at const v";
s1[12][0]="Cp/Cv, adiabatic constant ";
s1[13][0]="c, speed of sound "
s1[14][0]="viscosity "
s1[15][0]="thermal conductivity "
s1[16][0]="M, molecular weight
s1[17][0]="Prandtl number
s1[18][0]="Pr, reduced pressure "
s1[19][0]="vr, reduced volume "

if(SI && 'mole)

{

s1[0][2]=" bars "
s1[1][2]="deg K "
s1[2][2]=" m"3/kg
s1[3][2]=" kg/m"3
s1[4][2]=" KJ/kg "
s1[5][2]=" KJ/kg "
s1[6][2]=" KJ/kg K
s1[7][2]=" KJ/kg
s1[8][2]=" KJ/kg "
s1[9][2]=" KJ/kg "
s1[10][2]=" KJ/kg K
s1[11][2]=" KJ/kg K
s1[12][2]=" "
s1[13][2]=" m/s "
s1[14][2]=" Ns/m"2



s1[15][2]=" W/m K
s1[16][2]=" kg/kmol
s1[17][2]="
s1[18][2]="
s1[19][2]="

¥

else if(SI && mole)

{
s1[0][2]="
s1[1][2]="
s1[2][2]="
s1[3][2]="
s1[4][2]="
s1[5][2]="
s1[6][2]="
s1[7][2]="
s1[8][2]="
s1[9][2]="
s1[10][2]="
s1[11][2]="
s1[12][2]="
s1[13][2]="
s1[14][2]="
s1[15][2]="
s1[16][2]="
s1[17][2]="
s1[18][2]="
s1[19][2]="
k

bars

deg K
m”3/kmole
kmole/m”3
KJ/kmole
KJ/kmole

KJ/kmole K "

KJ/kmole
KJ/kmole
KJ/kmole

KJ/kmole K "
KJ/kmole K "

m/s

Ns/m”2
W/m K
kg/kmol

else if(!SI && mole)

{

s1[0][2]=" Ibf/in~2, psia *;

s1[1][2]="deg R



s1[2][2]=" ft*3/Ibmole
s1[3][2]=" Ibmole/ft"3
s1[4][2]=" BTU/Ibmole
s1[5][2]=" BTU/Ibmole
s1[6][2]=" BTU/lbmole K "
s1[7][2]=" BTU/Ibmole
s1[8][2]=" BTU/Ibmole
s1[9][2]=" BTU/Ibmole
s1[10][2]=" BTU/lbmole K "
s1[11][2]=" BTU/lbmole K "
s1[12][2]="

s1[13][2]=" ft/s

s1[14][2]=" Ibm/(ft.s)
s1[15][2]=" BTU/(hr ft R) ";
s1[16][2]="Ibm/Ibmole ";
s1[17][2]="

s1[18][2]="

s1[19][2]="

}

else if(1SI && 'mole)

{

s1[0][2]=" Ibf/in~2, psia *;
s1[1][2]="deg R

s1[2][2]=" ft*3/Ibm
s1[3][2]=" ft*3/Ibm
s1[4][2]=" BTU/Ibm
s1[5][2]=" BTU/lbm
s1[6][2]="BTU/lbomK "
s1[7][2]=" BTU/Ibm
s1[8][2]=" BTU/Ibm
s1[9][2]=" BTU/lbm
s1[10][2]=" BTU/IbmK "
s1[11][2]=" BTU/lbm K *



s1[12][2]="
s1[13][2]=" ft/s
s1[14][2]=" lbm/(ft.s)
s1[15][2]=" BTU/(hr ft R) ";
s1[16][2]=" lbm/lbmole
s1[17][2]="
s1[18][2]="
s1[19][2]="
}
double pp[]=property(v1,v2);
for(int 1=0;i<20;i++)
{siil[1]=""+pp[i];}

return si,

}

public double[] property(double t, double p)

{

double pp[]=new double[20];
pp[0]=p;

pp[1]=t;
pp[2]=v(t,p);
pp[3]=1.0/pp[2];
pp[4]=h(t);
pp[5]=u(t);
pp[6]=s(t.p);
pp[71=g(t.p);
pp[8]=ht(t);
pp[9]=gt(t,p);
pp[10]=Cp(V);
pp[11]=Cv(V);
pp[12]=gamma(t);
pp[13]=c(t);
pp[14]=vis(t);



pP[15]=k(t);
pp[16]=M;
pp[17]=Prandti(t);
pP[18]=pr(t);
pp[19]=vr(Y);
return pp;

}

}/end of class
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